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How to use this guide 

QTV WinCueProNews Guide provides detailed information on how to set up, configure and operate the 

WinCueProNews software. 

Audience 

This guide is intended for use by operators whose familiarity with computers and software ranges from novice to 

expert. 

Structure of this guide 

The WinCueProNews Guide is modular in design and can be divided into six parts. Each part describes a 

different mode of function for WinCueProNews and therefore can be used alone or in conjunction with other 

sections.  

Chapter 1 Installation 

 

Describes the hardware and software requirements. 

How to install the WinCueProNews software and 

peripherals 

Chapter 2 Introducing WinCueProNews Describes the WinCueProNews Screen, toolbars, 

menu commands and keyboard shortcuts 

Chapter 3 WinCueProNews Interfaces Describes how to set up and run the four versions of 

WinCueProNews. 

Chapter 4 WinCueProNews Basics Describes how to create and prompt scripts in four 

easy steps 

Chapter 5 The Script Editor Describes how to set read rates and customise 

settings for individual presenters 

Chapter 6 Working with Rundowns Describes how to create and prompt using rundowns 

 

Chapter 7  The Prompter Describes the different scroll controls and how they 

are configured 
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Chapter

1
 

Installation of WinCueProNews 

In this chapter you will learn how to install WinCueProNews on your PC. First we will examine the 

hardware and software you need, and then we will cover the hardware and software installation process. 

1 Installing WinCueProNews on your PC 

 

1.1 Minimum Hardware Requirements 

WinCueProNews will run on two different operating systems; Windows 95 and Windows NT 

4.0. The minimum hardware requirements for a PC running WinCueProNews will depend on 

the operating system you wish to use. Refer to the panels below: 

Windows 95 

�100MHz Pentium processor 

�32Mb RAM 

�50Mb free disk space 

�SCSI card Adaptec 2906 for desktop, 1460 PCMIA for laptop 

�VL bus or PCI bus graphics card (PCI preferred) 

� 640x480 colour VGA display (800x600 highly recommended) 

Windows NT 4.0 

� 100 MHz Pentium processor 

� 32Mb RAM 

� 50Mb free disk space 

� SCSI card Adaptec 2906 for desktop, 1460 PCMIA for laptop 

� VL bus or PCI bus graphics card (PCI preferred) 

� 640x480 16 colour VGA display (800x600 highly recommended) 
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1.2 Before Installing Your Chosen Operating System 

Before you install your chosen operating system you should configure your SCSI card in 

accordance with the documentation supplied with it.  DO NOT at this stage install any 

hardware supplied with WinCueProNews. This hardware should not be installed in your 

PC until the WinCueProNews software has been set up. 

 

1.3 The WinCueProNews Package 

The WinCueProNews package consists of: 

 

 

Laptop users will 

receive an I.M.T. 

box, not the I.M.T. 

scroll card 

� Software (4 diskettes incl. Licence diskette) 

� Licence (1 diskette) 

� I.M.T. Scroll Card 

� Scroll Control 

� Manual 

 

1.4 I.M.T. Scroll Card 

The I.M.T. scroll card allows WinCueProNews to prompt text in any language. Data from 

the scroll card is sent to the prompter screen via the on-board composite video channel. 

The I.M.T. card also features an on-board genlock port. In addition, an I.M.T. scroll 

control can be attached to the I.M.T. card leaving all the ports on your PC free for other 

peripherals. 

 

1.5 Installing the Software  

The first step in setting up WinCueProNews is to install the software. It is assumed you 

have already successfully installed your chosen operating system on a PC and this 

meets the minimum hardware requirements.   

 
 

  Warning! 

 If WinCueProNews is being installed on Windows NT 4.0 you will need to be 

logged in with administrator privileges.  If you do not have these rights contact 

your computer support department. 
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The software comes with an installation program this will prompt you for diskettes and 

information when they are needed. 

To begin installing WinCueProNews: 

1. Close all programs running on your computer 

2. Insert Disk 1 in the floppy drive of your computer 

3. Choose Run… from the Start menu 

 

4. The Run dialogue box appears. Type a:\setup in the Open: text box then click on OK. 

 

 

5.  The installation program will load. Follow the on screen instructions carefully.   

6. During the installation you will be asked to insert your licence disk (Disk 4). Once the 

information on this disk has been copied onto your PC the software installation is 

complete. 

7. Once all the software has been copied onto your PC you will need to shut it down and 

switch it off to install the I.M.T. scroll card. 
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Warning! 

 
The licence disk included with each copy of WinCueProNews is designed to work 

with the supplied I.M.T. scroll card.  It will not work with any other I.M.T. card. 

 

1.6 Installing the Hardware - Desktop PCs 

When the software has been installed and the PC turned off the I.M.T. scroll card can 

be installed. 

The I.M.T. card will have been configured prior to despatch for the settings required in 

your country. Therefore changes to jumpers or dipswitch settings should not be 

necessary. 

 

 

 

1.6.1 Installing the I.M.T. Card Inside a PC 

1. Remove the cover from the PC’s case 

2. If the I.M.T. card is not the only device connected to the PC’s SCSI card, add another 

SCSI connector to the SCSI cable if you have not already done so 

3. The I.M.T. card is configured it should be connected to the end of the SCSI cable. 

4. Find a free full length ISA slot inside the PC 

5. Remove the appropriate blanking plate 

6. Carefully insert the I.M.T. card 

7. Connect the SCSI cable to the I.M.T. card 

8. Replace the PC’s cover 

 

1.6.2 Connecting a Scroll Control 

The standard scroll control used with WinCueProNews is the I.M.T. scroll control. The 

I.M.T. scroll control port is the 9 pin analogue port on the back of the I.M.T. card. 

WinCueProNews expects the scroll control to be connected to this port.  

The I.M.T. scroll control will not work if it is attached to any other port on your PC. 

 

 

See Also 

Refer to Appendix C for wiring diagrams 

See Also 

Refer to chapter 6 to learn more about all the different scroll controls 

supported by WinCueProNews 
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1.6.3 Connecting a Composite Video Feed 

The composite video port is the BNC port furthest the scroll control port on the I.M.T. 

card. This port supplies the composite video feed to the prompter screen(s). 

 

1.6.4 Connecting a Genlock Feed 

The genlock port is the BNC port nearest from the scroll control port on the I.M.T. card. 

This port accepts a genlock feed. 

 

1.7 Installing the Hardware - Laptops 

When the software has been installed and the PC turned off the laptop can be 

connected to the I.M.T. box. 

 

The I.M.T. scroll card inside the I.M.T. box has been configured prior to despatch for the 

settings required in your country.  Therefore it should not be necessary to open the 

I.M.T. box or change jumpers or dip switch settings. 

 

 

 

1.7.1 Connecting the I.M.T. Box to a Laptop 

1.  Insert the PCMCIA SCSI card into your laptop 

2.  Connect one end of the SCSI cable supplied with the SCSI card to the PCMCIA card 

and the other to the SCSI port on the I.M.T. box 

3.  Connect a power cord to the appropriate input of the I.M.T. box (you have a choice of 

IEC mains or 12V DC) 

 

1.7.2 Connecting a Scroll Control 

Laptops normally use the I.M.T. scroll control. The I.M.T. scroll control port is the 9 pin 

analogue port on top of the I.M.T. box. WinCueProNews expects a scroll control to be 

connected to this port.   

 

The I.M.T. scroll control will not work if it is attached to any other port on your PC. 

 

See Also 

Refer to the laptop-wiring diagram in Appendix C 
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1.7.3 Connecting a Composite Video Feed 

The I.M.T. box is made in two versions, one has four BNC composite outputs and the 

other has one. These ports supply the composite video feed to the prompter screen(s). 

You can connect your video cable to the BNC output. 

 

 

1.7.4 Connecting a Genlock Feed 

The genlock port is the BNC port next to the I.M.T. scroll control port on the I.M.T. box. 

This port accepts a genlock feed. 

1.7.5Connecting a Power Supply 

The I.M.T. box can be powered from one of three different sources; the mains power 

supply, 12V DC and an optional PAG battery (UK version only). 

 

A reset button is provided on the I.M.T. box to reset the I.M.T. scroll card. 

 

1.8 Restarting Your PC 

Once all the WinCueProNews hardware has been installed restart your PC. 

 

 

 

Warning for Laptop Users! 

 Laptop users must switch on the I.M.T. box before switching on the laptop. This 

is to ensure the PCMCIA SCSI card successfully detects the I.M.T. scroll card. 

 

 

1.9 Starting WinCueProNews for the First Time 

When WinCueProNews starts for the first time the following message appears, “Your 

scroll control configuration is not set. WinCueProNews will now allow you to select 

which scroll control your have installed”. 

 

 

 

 

See Appendix C3 & C4 for further details 
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Click on OK. The Configure Scroll Controls dialogue box appears. 

 

Choose the appropriate scroll control from the Configure Scroll Controls dialogue box, 

and then click on OK. 

The WinCueProNews installation is now complete and you ready to begin working with 
WinCueProNews. 
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Word count and Script 
duration boxes 

How WinCueProNews Works 

 

This Chapter introduces WinCueProNews and some of its basic features. If you are familiar with Windows 

you can skip ahead to the next chapter which describes how to create a document. This chapter is also a 

valuable reference section as it describes all the keystroke shortcuts. 

2 Introducing WinCueProNews 

2.1 What’s on the WinCueProNews Screen? 

When you start WinCueProNews, a new blank document appears on the WinCueProNews 

Screen. The following illustration identifies each part of the WinCueProNews screen. 

Menu Bar 
Toolbars 

Status bar 

Script Editor 

Chapter

2
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Open menu on the menu bar to display WinCueProNews commands. 

 

Click buttons on the toolbars to quickly choose commands 

The status bar displays information about the active document or highlighted command. The 

window bar displays the current scripts open as tabs. 

One of the main features of the WinCueProNews screen is the Word count boxes and the 

Script duration boxes. 

 

 

As you type the script into WinCueProNews, the Word Count box will track the number of 

words in the script. The current word count is constantly updated and displayed. The Words 

to End box will track the number of words remaining in the script, from a specific point within 

the script. 

The screens described in this section refer to WinCueProNews LT in standard format 

although all screens are configurable using the Layout Editor. Contact your vendor for more 

details. 

See Also 

Section 5.1.2 for more details on the Word Count boxes and Script duration box 
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2.2 Using the Mouse 

Use the mouse to move the pointer around on the screen to quickly choose commands, click 

buttons, and select text and so on. To move the pointer, just move the mouse on your 

desktop. 

2.3 Choosing Commands 

A command is an instruction that tells WinCueProNews what to do next. To choose 

commands, you can click buttons on the toolbars or use the regular menus. 

Using toolbars for command shortcuts  If you have a mouse you can click buttons on the 
toolbar to choose the most common WinCueProNews commands. 

Formatting tool bar 

Standard toolbar 

To display or hide a toolbar, choose Toolbars from the Tools menu, select the toolbar you 

want to display or hide. The Toolbar selected will have a check mark (�) displayed when the 

command is “on”. 

Choosing commands from the menus  You can also choose commands from menus that 

are listed on the menu bar at the top of the WinCueProNews window. Just click the 

command you want. To close a menu without choosing a command, click outside the menu 

or press ESC. 

 

An ellipsis (dot dot) means the 
command displays a dialogue box 
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Selecting options in a dialogue box  When you choose a command that’s followed by an 
ellipsis (…), a dialogue box appears so that you can select options. 

 

 

 

 

2.4 WinCueProNews toolbars and tools 

Toolbars provide quick access to commonly used commands and tools. When you first start 

WinCueProNews and open a queue, the Standard and Formatting toolbars are displayed just 

below the menu bar. You can choose the toolbars you want to display or you can choose to 

display none at all. 

 

Command button: 
click it to carry out 
action 

Drop down list: click 
the arrow to see the 
options you can 
select 

Buttons: Select to view 
options 



WINCUEPRONEWS USER GUIDE 

VERSION 1.30B515 20  QTV 1998 

2.4.1 Standard Toolbar 

To select the standard toolbars choose Tools, then Toolbars from the menu. A sub menu 

will appear and select standard. A check mark (����) indicates the command is on. 

 

Function Button 

New File button 
 

Open File button 
 

Open Queue button 
 

Quick browser button 
 

Save queue button 
 

Print button 
 

Paste button 
 

Copy button 
 

Cut button 
 

Prompt button 
 

Stop prompting button 
 

Panic button 
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2.4.2 Formatting Toolbar 

 

Function Button 

Bold button 
 

Underline button 
 

Italic button 
 

Inverse button 
 

Font button 
 

Colour button-white, red, green, blue, 

yellow 

 

Justify button -right, centre, left 
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2.5 WinCueProNews Keyboard Shortcut 

2.5.1 Text Formatting 

To do this Windows Shortcut 

Underline Ctrl + U 

Italic Ctrl + I 

Bold Ctrl + B 

Change font Ctrl + F 

Inverse Text Ctrl + E 

Colour change to Default colour (black) Ctrl + 0 

Colour change to Red Ctrl + 1 

Colour change to Green Ctrl + 2 

Colour change to Blue Ctrl + 3 

Colour change to Yellow Ctrl + 4 

Justify text right Ctrl + Shift + R 

Justify text left Ctrl + Shift + L 

Format all Text Ctrl + Shift + A 

Select all Text Ctrl + A 

 

 

2.5.2 Deleting and Copying 

To do this Windows shortcut 

Cut Ctrl + X 

Copy Ctrl + C 

Paste Ctrl + V 

Search/replace Ctrl + H 

 

2.5.4 Prompting Shortcuts 

 

To do this Windows shortcut 

Insert marker Ctrl + M 

Previous marker in script Ctrl + 9 

Next marker Ctrl + 0 

Not prompted text Ctrl + P 
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2.5.5 Menu Commands 

To use this command Windows shortcut 

Save File Ctrl + S 

 

 

2.5.6 Function Key Commands 

 

Key To do this 

F1 Help 

F3 Find Next 

F3 + Shift Next 

F6 Open next item 

F6 + Shift Open previous item 

F7 Commit edits 

F9 Prompter Refresh 

F11 Edit at prompter 

F11 + Shift Prompt to Editor 

F11+ Ctrl Prompt scroll lock 

 

 

2.6 The Principles of Prompting 

This section aims to provide those who are unfamiliar with prompting systems the basic terms 

involved.  

2.6.1 Prompters 

The prompter is normally mounted on the front of the camera and displays the scrolling text 

created by the script editor for the presenter to read. The text from the monitor is reflected 

onto a special sheet of glass. Thus the presenter can see the text, but the camera looks 

straight through it. 

2.6.2 The Script Editor 

The script editor is used to write and modify the story the presenter is going to read. Each 

story is represented as a one-line entry in the rundown. 
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2.6.3 Rundowns 

A rundown is a list of titles representing the stories the presenter is going to read. The order in 

which the titles appear dictates the order in which the stories will be displayed on the 

prompter. 

2.6.4 The Scroll Controller 

The scroll controller is used to control the prompted text. The prompter operator controls the 

speed and direction the text scrolls to suit the presenter.  
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WinCueProNews Interfaces 
In this chapter we explore the different types of interfaces applicable to WinCueProNews. 

3 WinCueProNews Interfaces 

3.1 WinCue AP NewsCentre. 

3.1.1 Setting up WinCue to access AP NewsCentre runorders    

Left-click on the 'Tools' menu and then select 'Options...' from the drop-down menu that 

appears. 

The 'WinCue Configuration' dialog box will then appear. 

Double left-click on the 'News Interfaces' item in the right list box. 

The 'AP NewsCentre' item will then appear under the 'News Interfaces' item. 

Left-click (select) the 'AP NewsCentre' item 

The 'AP NewsCentre' configuration property pages will then appear to the left of the list box. 

Chapter

3
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The 'Servers' property page is displayed. 

Left-click on the 'Add' button. 

The 'Modify NewsCentre Server' dialog box is now displayed. 

Enter a 'Name' for the server, this is a name used for reference purposes within WinCue for 

these settings and therefore doesn't have to be the servers computer name. (e.g. Name: AP 

NewsCentre One) 

Enter a 'Path' for the server, this is the fully qualified network path for the AP NewsCentre 

queue folders, it may be easier to use the 'Browse' button to help find the AP NewsCentre 

queue folder path. The AP NewsCentre root queue folder contains sub-folders named by 

year, then month, then day (eg. \1998\05\28), you should make the server path be the 

location of the top most of these folders so that all the sub-folders can be navigated to from 

within WinCue using the 'Runorder/Queue Browser'. 

Once all this server information has been entered, left-click on the 'OK' button, the server 

name will now be listed under 'Configured Servers'. 

Now left-click on the 'Other Settings' tab. 

Left-click on the 'Font' button, a font selection dialog will now be displayed, this is the font to 

be used for prompting, a font size of between 80 and 100 is advisable. 

When you are happy with your 'AP NewsCentre' settings, left-click on the 'WinCue 

Configuration' dialogs 'OK' button, this will save your settings. 
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Left-click on the 'Tools' menu and then select 'Options...' from the drop-down menu that 

appears. 

The 'WinCue Configuration' dialog box will then appear. 

Left-click on the 'User Preferences' item in the right list box. 

The 'User Preferences' configuration property pages will then appear to the left of the list 

box. 

Set all the options for the 'User Interface' the same as in the above screen shot. 

 

Now, left-click on the 'Windows' tab. 
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Set all the options for the 'Windows' the same as in the above screen shot. 

Now, left-click on the 'Prompt Tracking' tab. 
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Set all the options for the 'Prompt Tracking' the same as in the above screen shot. 

When you are happy with your 'User Preferences' settings, left-click on the 'WinCue 

Configuration' dialogs 'OK' button, this will save your settings. 

NOTE: It is now advisable to close down the WinCue program and re-start it. 

If you have successfully completed all the above then you are now ready to open an AP 

NewsCentre runorder and prompt it. 

NOTE: This manual assumes that you have set up WinCue to work with AP 

NewsCentre using the 'WinCue with AP NewsCentre ' set up guide. 
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3.1.2 Starting WinCue AP NewsCentre 

If WinCue is not currently running: 

Double-click with the mouse on the “'WinCue” icon displayed on the screen.  

The 'Runorder/Queue Browser' will automatically be displayed once WinCue is running. 

3.1.3 Opening an AP NewsCentre Runorder on WinCue 

First ensure the 'Runorder/Queue Browser' is open: 

NOTE: WinCue should only ever be in one of two states, either the 'Runorder/Queue 

Browser' is displayed or an ' AP NewsCentre Runorder' (list of stories) is displayed. 

If WinCue is running but nothing is displayed (i.e. neither the 'Runorder/Queue 

Browser' or an AP NewsCentre Runorder is displayed): 

 

Left-click on the red toolbar icon which looks like a folder. 

Or 

Left-click on the 'File' menu and then select 'Open Queue' from the drop-down menu. 
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The 'Runorder/Queue Browser' will then be displayed. 

If a ' AP NewsCentre Runorder' is currently displayed (a list of runorder stories): 

Close the runorder by left-clicking on the lower of the two 'X's in the top-right of the screen, 

or clicking on 'Close' under the 'File' menu.  

 

A message box will appear if you are currently prompting this runorder. It will ask if you if you 

are sure you want to close it, select 'Yes' if you are sure. Once all the open runorders are 

closed, the 'Runorder/Queue Browser' will automatically be displayed. 

3.1.4 The 'Runorder/Queue Browser': 

From this box it is possible to access all the available AP NewsCentre runorders. If the 

runorder that you wish to load (for prompting) is not listed in this box then you may need to 

navigate through the folders (directories) to find the folder containing the runorder you 

require. 

 
To open an AP NewsCentre Runorder on WinCue ready for prompting, do either of the 

following: 

Double left-click on the runorder that you want to open.  Or 
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Left-click (select) the runorder you want to open and then click on the 'OK' button. 

The runorder will then be opened and be set ready to start prompting see 'Prompting an AP 

NewsCentre Runorder on WinCue'. 

Closing an AP NewsCentre Runorder on WinCue 

Close a runorder by left-clicking on the lower of the two 'X's in the top-right of the screen, or 

clicking on 'Close' under the 'File' menu.   

A message box will appear if you are currently prompting the runorder. It will ask if you are 

sure that you want to close it, select 'Yes' if you are sure. 

Once all the open runorders are closed, the 'Runorder/Queue Browser' will automatically 

be displayed, if this is not so then go to  

'Opening an AP NewsCentre Runorder on WinCue'. 

3.1.5 Prompting an AP NewsCentre Runorder on WinCue 

NOTE: An AP NewsCentre Runorder should be prompted from start to finish in listed 

order (i.e. The prompt operator is not required to jump back and forth within a 

runorder. The runorder should be re-ordered using AP NewsCentre.) 

SAFE PRACTICE: Due to the way in which AP NewsCentre updates the prompter 

automatically it is necessary that if the prompting between two stories is not 

continuous (e.g. The prompt is stopped at the end of a story while a video clip is 

played (VT)) the prompt operator does not pre-empt the gallery by prompting into what 

they believe to be the next story to be prompted. 

3.1.6 Information displayed on the WinCue runorder: 

A yellow bar on the runorder indicates which story you are currently prompting, the 'prompt 

bar'. 

A black bar on the runorder indicates which story you have 'selected'. This can be done by 

left-clicking on with the mouse, this black bar can be ignored. 

Double left-click on a story to view the text of the story, use the far-right scroll bar to view 

more of the story. 
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The runorder word count column displays the number of words in a story. If there are no 

words in a story its word count box will be coloured red to indicate that it may be worth 

querying the gallery why there is no text in the story. It is only worthwhile querying a story if 

you believe that there should be some text in the story. 

The runorder status column displays information about the status of a story. 

If a stories status box is coloured red it indicates that the status information is relatively 

important and may be worth querying. 

3.1.7 The Various Status Messages and Their Meanings: 

The following two messages will appear in red status boxes as they are generally error 

messages. 

IMPORT FAILED - The story file has been read but it has not been possible for WinCue 

to import the text. 

Likely cause: The file may have been corrupted in some way. 

DATA OUT OF DATA - The story file has already been successfully imported by 

WinCue, but the subsequent update of the story has been read but it has not been 

possible for WinCue to import the text. 

Likely cause: The file may have been corrupted in some way. 

3.1.8 Using the Scroll Controllers: 

NOTE: IF YOU HAVE A MULTIBUTTON CONTROL WITH OR WITHOUT A FOOT 

CONTROL: 

The button on the back of the Multibutton Hand Control switches between whether the 

Multibuttons scroll knob or the attached Foot Controls (NB. A Foot Controller may not 

be attached) pedal is to control the scrolling. 

If the button is OUT then the scrolling is controlled by the Multibuttons scroll knob. 

If the button is IN then the scrolling is controlled by the Foot Controls pedal. 

Using the Multibutton Hand Control to prompt 
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The Multibutton Hand Control has twelve buttons and a scroll knob on its right hand side. The 

scroll speed is controlled by turning the knob. The functions of all the buttons on the 

Multibutton are listed below: 

Top row of buttons (left to right): 

FWD  Change the scroll direction. The scroll direction is indicated by the cue    

REV   marker on the prompt output. If the cue marker points in towards the story,  

you are scrolling forwards. 

NEXT  Jump the prompt forward to the next story. (an ITEM is a STORY) 

ITEM 

PREV  Jump the prompt back to the previous story. 

ITEM 

RESET  Reset the prompt back to the start of the current story. 

ITEM 

Middle row of buttons (left to right): 

NEXT  Same function as NEXT ITEM. 

MARKER 

PREV  Same function as PREV ITEM. 

MARKER 

RESET  Reset the prompt back to the start of the current runorder. 

R.O. 

BLANK  Blanks/Un-blanks the prompt output. (Useful if you feel an interviewer may 

SCREEN  be put off by prompt on the camera) 

Bottom row of buttons (left to right): 

CAPTION  Dependant on whether you are using WinCue for Captioning. 
ON/OFF 
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2nd from left, Known as the  'CUE STORY' button, it will move the prompt back to the 

bottom row. very end of the previous story. This is useful to ensure that you are not pre- 

empting the gallery as to which is the next story to prompt. Yet you are still 

able to display enough of the next story for the presenter to start reading it. 

CLEAR  Dependant on whether you are using WinCue for Captioning. 

DECODER 

STOP  Stop/Re-start the prompt scrolling. 

Using the Foot Control to prompt 

The scroll speed is controlled by increasing and decreasing the pressure applied to the foot 

pedal (much like a car accelerator pedal). The red button on the foot control changes the 

scroll direction in the same way as the Multibutton controllers FWD REV button. 

If the Foot Control is attached to the back of a Multibutton Hand Control then the Foot Control 

can be used in combination with the Multibutton Controls buttons. 

3.1.9 Using WinCue to select the next story to prompt: 

If it is necessary to jump the prompt to a story that is not the next or previous story in the 

runorder then you can use any of the following three methods. 

1: Hold down the left 'Alt' key and double left-click on the story you want to start 

prompting. 

2: Right-click on the story you want to start prompting, then select 'Prompt From Here' 

from the drop-down menu that appears. 

3: Left-click on the story you want to start prompting, this will select the story (shown by 

the black bar), then hold down the left 'Alt' key and press the 'Return' or 'Enter' key. 

After using any one of these methods, the prompt and the WinCue prompt (yellow) bar will 

move/jump to the chosen story. 
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3.1.10 Using 'Panic Mode' if AP NewsCentre stops working: 

WinCue has a 'Panic Mode' option that allows AP NewsCentre Runorders and stories to be 

manipulated from WinCue if the AP NewsCentre system stops working for any reason such 

as a network failure. 

IMPORTANT: The 'Panic Mode' feature should only be used as a last resort. 

If 'Panic Mode' is enabled the WinCue terminal will stop trying to read updates from AP 

NewsCentre, as soon as 'Panic Mode' is disabled the WinCue terminal will re-start trying to 

read updates from AP NewsCentre. 

NOTE: Any changes to the runorder and stories on WinCue while in 'Panic Mode' will 

be lost as soon as 'Panic Mode' is disabled. 

3.1.11 Enabling/Disabling 'Panic Mode': 

Left-click on the 'Panic Mode' icon on the tool bar at the top of the screen to toggle 'Panic 

Mode'. When the button is shown as pressed in 'Panic Mode' is enabled, otherwise it is 

disabled: 

    

Disabled  Enabled 

 

3.1.12 While in 'Panic Mode': 

The runorder can be changed on WinCue by dragging and dropping stories with the mouse. 

To Delete/drop a story, left-click (select) the story and then press the 'Delete' key, the story 

will then be moved to the 'Trash Can' at the bottom of the screen (stories can be dragged 

back out of the 'Trash Can'). 

To Insert a New story, right-click below the placement for the new story. 

A drop-down menu will then appear, select 'New', then 'Single-column Script'. 

You will be asked for the name/title of the new story, type it in and select the 'OK' button. 
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Double-click on a story to view it and edit it. The editor works in a similar way to most 

Windows Word Processors. 

IMPORTANT: You must press the 'F7' function key after editing a story for it to be 

updated on the prompt output. 

3.1.13 Changing the Font and Font Size for prompting on WinCue. 

To change the default font or font size for all AP NewsCentre runorders you must do the 

following: 

Left-click on the 'Tools' menu and then select 'Options...' from the drop-down menu that 

appears. 

The 'WinCue Configuration' dialog box will then appear. 

Double left-click on the 'News Interfaces' item in the right list box. 

The ' AP NewsCentre ' item will then appear under the 'News Interfaces' item. 

Left-click (select) the ' AP NewsCentre ' item 

The ' AP NewsCentre ' configuration property pages will then appear to the left of the list 

box. 

Left-click on the 'Other Settings' tab. 

Left-click on the 'Font' button. 



WINCUEPRONEWS USER GUIDE 

VERSION 1.30B515 38  QTV 1998 

Now go to 'Changing Font and/or Font Size' . 

Changing Font and/or Font Size: 

The following presumes that the 'Select Font' dialog box is currently visible, if it is not then go 

to 'Changing the Font and Font Size for prompting on WinCue'. 

To change the Font Size: 

Left-click (select) the new font size or use the arrow buttons on the right of the 'Font Size' box 

to select a new font size, a preview of the font is visible in the box at the bottom of the dialog 

box. 

To change the Font: 

Left-click (select) the new font that you want to use in the 'Available Fonts' list box, a 

preview of the font is visible in the box at the bottom of the dialog box. 

If you are happy with your new Font and/or Font Size, left-click on the 'OK' button. 

If you are not happy and do not want to use your new Font and/or Font Size, left-click on 

the 'CANCEL' button. 
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3.2 WinCue AP ENPS 

IMPORTANT: A directory must first be set up that the ENPS system can 'Dump' (write 

files) to, this directory must be accessable by both the terminal with WinCue installed 

and the ENPS terminals set up to 'Dump' to WinCue. 

3.2.1 Setting up WinCue to access AP ENPS Runorders 

Left-click on the 'Tools' menu and then select 'Options...' from the drop-down menu that 

appears. 

The 'WinCue Configuration' dialog box will then appear. 

Double left-click on the 'News Interfaces' item in the right list box. 

The 'AP ENPS' item will then appear under the 'News Interfaces' item. 

Left-click (select) the 'AP ENPS' item 

The 'AP ENPS' configuration property pages will then appear to the left of the list box. 

The 'Servers' property page is displayed. 

 

 

 

 

 

 

 

Left-click on the 'Add' button. 
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The 'Modify ENPS Server' dialog box is now displayed. 

Enter a 'Name' for the server, this is a name used for reference purposes within WinCue for 

these settings and therefore doesn't have to be the servers computer name. (e.g. Name: 

ENPS One) 

Enter a 'Path' for the server, this is the fully qualified network path for the directory that ENPS 

terminals can 'Dump' to, it may be easier to use the 'Browse' button to help find this 

directory. 

Once all this server information has been entered, left-click on the 'OK' button, the server 

name will now be listed under 'Configured Servers'. 

Now left-click on the 'Other Settings' tab. 

Left-click on the 'Font' button, a font selection dialog will now be displayed, this is the font to 

be used for prompting, a font size of between 80 and 100 is advisable. 

Depending on the way that you want WinCue to work with ENPS, select the behaviour you 

are going to allow, such as whether you want to 'Allow On-Air Item Deletes'. The default 

options are recommended. 

 

When you are happy with your 'AP ENPS' settings, left-click on the 'WinCue 

Configuration' dialogs 'OK' button, this will save your settings. 

3.2.2 Setting up WinCue to display ENPS Runorders 
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Left-click on the 'Tools' menu and then select 'Options...' from the drop-down menu that 

appears. 

The 'WinCue Configuration' dialog box will then appear. 

Left-click on the 'User Preferences' item in the right list box. 

The 'User Preferences' configuration property pages will then appear to the left of the list 

box. 

Now, left-click on the 'Windows' tab. 
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Now, left-click on the 'Prompt Tracking' tab. 

Set all the options for the 'Prompt Tracking' the same as in the above screen shot. 

When you are happy with your 'User Preferences' settings, left-click on the 'WinCue 

Configuration' dialogs 'OK' button, this will save your settings. 

 

NOTE: It is now advisable to close down the WinCue program and re-start it. 

 

If you have successfully completed all the above then you are now ready to open an ENPS 

runorder and prompt it, see the section learn how to do this. 

 

 

 

 

3.2.3 Starting WinCue AP ENPS 
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NOTE: It should never be necessary for a user to start WinCue, as the program should 

never be exited. 

If the computer is not logged in and is displaying the 'Press Ctrl + Alt + Delete to log on': 

Do as instructed and hold down 'Ctrl-Alt-Delete'. 

A new message will now be displayed asking for a 'User name' and 'Password'. 

The 'User name' is 'Operator'. 

The 'Password' is 'QTV' (all in lowercase). 

The logging in procedure will automatically run WinCue and display the 'Runorder/Queue 

Browser'. 

Now go to 'Opening an ENPS Runorder on WinCue'. 

If WinCue is not currently running: 

Double-click with the mouse on the 'WinCue' icon displayed on the screen.  

The 'Runorder/Queue Browser' will automatically be displayed once WinCue is running. 

Now go to 'Opening an ENPS Runorder on WinCue'.Opening an ENPS Runorder on 

WinCue 

First ensure the 'Runorder/Queue Browser' is open: 

NOTE: WinCue should only ever be in one of two states, either the 'Runorder/Queue 

Browser' is displayed or an 'ENPS Runorder' (list of stories) is displayed. 

If WinCue is running but nothing is displayed (i.e. neither the 'Runorder/Queue Browser' or an 

ENPS Runorder is displayed): 
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Left-click on the red toolbar icon which looks like a folder. Or 

Left-click on the 'File' menu and then select 'Open Queue' from the drop-down menu. 

 

The 'Runorder/Queue Browser' will then be displayed. 

If an 'ENPS Runorder' is currently displayed (a list of runorder stories): 

Close the runorder by left-clicking on the lower of the two 'X's in the top-right of the screen.  

   

A message box will appear if you are currently prompting this runorder. It will ask if you if you 

are sure you want to close it, select 'Yes' if you are sure. Once all the open runorders are 

closed, the 'Runorder/Queue Browser' will automatically be displayed. 

 

 

 

 

3.2.4 The 'Runorder/Queue Browser': 
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All the available runorders that have been dumped from the ENPS terminal are listed in his 

box.  

If the runorder that you wish to load (for prompting) is not listed in this box ensure that the 

runorder has been dumped from the ENPS terminal (see 'Dumping an ENPS Runorder to 

WinCue'). 

To open an ENPS Runorder on WinCue ready for prompting, do either of the following: 

Double left-click on the runorder that you want to open. 

Or 

Left-click (select) the runorder you want to open and then click on the 'OK' button. 

The runorder will then be opened and be set ready to start prompting 'Prompting an ENPS 

Runorder on WinCue'. 

 

 

 

3.2.5 Deleting an old ENPS Runorder from WinCue 
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NOTE: Deleting old ENPS Runorders from the WinCue computer does not in anyway 

affect ENPS, it purely deletes files off of the actual WinCue computer. 

After a number of ENPS Runorders have been 'dumped' to WinCue, the 'Runorder/Queue 

Browser' will become cluttered with old runorders. These runorders are deleted using the 

'Runorder/Queue Browser'. 

It is the WinCue operators responsibility to delete old ENPS Runorders from the WinCue 

computer. 

3.2.6 How to delete an ENPS Runorder from WinCue: 

First: Ensure that the ENPS terminal is not currently 'dumping' to WinCue the ENPS 

Runorder that you want to delete (i.e. The runorder on the ENPS terminal must be closed or 

the 'Dump to WinCue' for the runorder is not enabled). 

Second: Close all open runorders on WinCue so that the 'Runorder/Queue Browser' is 

displayed. 

Left-click (select) the runorder you want to delete and then click on the delete runorder icon: 

You will then be requested to confirm that you are sure you want to delete the selected ENPS 

Runorder.  

The ENPS Runorder will then be deleted from the WinCue computer and will disappear from 

the 'Runorder/Queue Browser'. 

 

3.2.7 Closing an ENPS Runorder on WinCue 

Close a runorder by left-clicking on the lower of the two 'X's in the top-right of the screen.  



WINCUEPRONEWS USER GUIDE 

VERSION 1.30B515 47  QTV 1998 

A message box will appear if you are currently prompting the runorder. It will ask if you are 

sure that you want to close it, select 'Yes' if you are sure. 

Once all the open runorders are closed, the 'Runorder/Queue Browser' will automatically 

be displayed, if this is not so then go to 'Opening an ENPS Runorder on WinCue'. 

 

3.2.8 Prompting an ENPS Runorder on WinCue 

NOTE: An ENPS Runorder should be prompted from start to finish in listed order (i.e. 

The prompt operator is not required to jump back and forth within a runorder. The 

runorder should be re-ordered on ENPS.) 

SAFE PRACTICE: Due to the way in which ENPS updates the prompter automatically 

it is necessary that if the prompting between two stories is not continuous (e.g. The 

prompt is stopped at the end of a story while a video clip is played (VT)) the prompt 

operator does not pre-empt the gallery by prompting into what they believe to be the 

next story to be prompted. 

Information displayed on the WinCue runorder: 

A yellow bar on the runorder indicates which story you are currently prompting, the 'prompt 

bar'. 

A black bar on the runorder indicates which story you have 'selected'. This can be done by 

left-clicking on with the mouse, this black bar can be ignored. 

Double left-click on a story to view the text of the story, use the far-right scroll bar to view 

more of the story. 

The runorder word count column displays the number of words in a story. If there are no 

words in a story its word count box will be coloured red to indicate that it may be worth 

querying the gallery why there is no text in the story. It is only worthwhile querying a story if 

you believe that there should be some text in the story. 

The runorder status column displays information about the status of a story. 

If a stories status box is coloured red it indicates that the status information is relatively 

important and may be worth querying. 



WINCUEPRONEWS USER GUIDE 

VERSION 1.30B515 48  QTV 1998 

The various status messages and their meanings: 

Updated - The story has been updated by ENPS. 

The following four messages will appear in red status boxes as they are generally error 

messages. 

MISSING - The story file has not been received from the ENPS terminal. 

Likely cause: The story may not contain any text on the ENPS terminal. 

IMPORT FAILED - The story file has been sent but it has not been possible for WinCue to 

import the text. 

Likely cause: The file may have been corrupted in some way. 

Possible solution: Re-dump the ENPS runorder. 

OUT OF DATE - MISSING - The story file has already been sent by ENPS and read by 

WinCue, but has since been removed/deleted. 

Likely cause: The ENPS runorder has been re-dumped or more than one ENPS terminal is 

dumping to WinCue simultaneously. If either one of these cases is true then this message 

can be ignored. 

DATA OUT OF DATA - The story file has already been sent by ENPS and read by WinCue, 

but has not been updated as expected. 

Likely cause: The ENPS runorder has been re-dumped or more than one ENPS terminal is 

dumping to WinCue simultaneously. If either one of these cases is true then this message 

can be ignored. 

 

3.2.9 Using the Scroll Controllers: 

 

NOTE: IF YOU HAVE A MULTIBUTTON CONTROL WITH OR WITHOUT A FOOT 

CONTROL. 
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The button on the back of the Multibutton Hand Control switches between whether the 

Multibuttons scroll knob or the attached Foot Controls (NB. A Foot Controller may not be 

attached) pedal is to control the scrolling. If the button is OUT then the scrolling is controlled 

by the Multibuttons scroll knob. 

If the button is IN then the scrolling is controlled by the Foot Controls pedal. 

Using the Multibutton Hand Control to prompt 

The Multibutton Hand Control has twelve buttons and a scroll knob on its right hand side. The 

scroll speed is controlled by turning the knob.  

The functions of all the buttons on the Multibutton are listed below: 

Top row of buttons (left to right): 

FWD Change the scroll direction. The scroll direction is indicated by the cue 

REV marker on the prompt output. If the cue marker points in towards the story, 

you are scrolling forwards. 

NEXT  Jump the prompt forward to the next story. (an ITEM is a STORY) 

ITEM 

PREV  Jump the prompt back to the previous story. 

ITEM 

RESET  Reset the prompt back to the start of the current story. 

ITEM 

Middle row of buttons (left to right): 

NEXT  Same function as NEXT ITEM. 

MARKER 

PREV  Same function as PREV ITEM. 

MARKER 

RESET  Reset the prompt back to the start of the current runorder. 

R.O. 
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BLANK    Blanks/Un-blanks the prompt output. (Useful if you feel an interviewer may 

SCREEN  be put off by prompt on the camera) 

Bottom row of buttons (left to right): 

CAPTION  No assigned function for the ENPS Interface. 

ON/OFF 

2nd from left, Known as the  'CUE STORY' button, it will move the prompt back to the 

bottom row. very end of the previous story. This is useful to ensure that you are not pre- 

empting the gallery as to which is the next story to prompt. Yet you are still 

able to display enough of the next story for the presenter to start reading it. 

CLEAR  No assigned function for the ENPS Interface. 

DECODER 

STOP  Stop/Re-start the prompt scrolling. 

 

3.2.10 Using the Foot Control to prompt 

The scroll speed is controlled by increasing and decreasing the pressure applied to the foot 

pedal (much like a car accelerator pedal). The red button on the foot control changes the 

scroll direction in the same way as the Multibutton controllers FWD REV button. 

If the Foot Control is attached to the back of a Multibutton Hand Control then the Foot Control 

can be used in combination with the Multibutton Controls buttons. 

3.2.11 Using WinCue to select the next story to prompt: 

If it is necessary to jump the prompt to a story that is not the next or previous story in the 

runorder then you can use any of the following three methods. 

1: Hold down the left 'Alt' key and double left-click on the story you want to start 

prompting. 

2: Right-click on the story you want to start prompting, then select 'Prompt From 

Here' from the drop-down menu that appears. 
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3: Left-click on the story you want to start prompting, this will select the story (shown 

by the blackbar), then hold down the left 'Alt' key and press the 'Return' or 'Enter' key. 

After using any one of these methods, the prompt and the WinCue prompt (yellow) bar will 

move/jump to the chosen story. 

3.2.12 Using 'Panic Mode' if ENPS stops working: 

WinCue has a 'Panic Mode' option that allows ENPS Runorders and stories to be 

manipulated from WinCue if the ENPS system stops working for any reason such as a 

network failure. 

IMPORTANT: The 'Panic Mode' feature should only be used as a last resort. 

If 'Panic Mode' is enabled the WinCue terminal will stop trying to receive updates from 

ENPS, as soon as 'Panic Mode' is disabled the WinCue terminal will re-start trying to 

receive updates from ENPS. 

NOTE: Any changes to the runorder and stories on WinCue while in 'Panic Mode' will 

be lost as soon as 'Panic Mode' is disabled. 

3.2.13 Enabling/Disabling 'Panic Mode': 

Left-click on the 'Panic Mode' icon on the tool bar at the top of the screen to toggle 'Panic 

Mode'. When the button is shown as pressed in 'Panic Mode' is enabled, otherwise it is 

disabled: 

Disabled    Enabled 
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While in 'Panic Mode': 

The runorder can be changed on WinCue in the same way that it is changed on ENPS 

(i.e. Dragging and dropping stories with the mouse). 

To Delete/drop a story, left-click (select) the story and then press the 'Delete' key, the story 

will then be moved to the 'Trash Can' at the bottom of the screen (stories can be dragged 

back out of the 'Trash Can'). 

To Insert a New story, right-click below the placement for the new story. 

A drop-down menu will then appear, select 'New', then 'Single-column Script'. 

You will be asked for the name/title of the new story, type it in and select the 'OK' button. 

Double-click on a story to view it and edit it. The editor works in the similar way as the ENPS 

editor, but stories do not have to be saved. 

3.2.14 Changing the Font and Font Size for prompting  on WinCue 

Changing the Font and Font Size only for the current runorder 

To change the font or font size for just the current runorder you must do the following: 

NOTE: If you want the new Font and Font Size to affect the current runorder and the 

default for all ENPS Runorders you should place a tick (by left clicking on the box) in 

the 'Save as default' tick box on the 'ENPS Rundown Properties' dialog boxes 'Other 

Settings' page. 

Left-click on the 'File' menu and then select 'Properties' from the drop-down menu that 

appears. 

The 'ENPS Rundown Properties' dialog box will then appear, the 'Other Settings' page will 

be automatically displayed. 

Left-click on the 'Font' button. 

Now go to 'Changing Font and/or Font Size' on the next page. 
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3.2.15 Changing the Font and Font Size of the default font setting affecting all runorders: 

 

To change the default font or font size for all ENPS runorders you must do the following: 

Left-click on the 'Tools' menu and then select 'Options...' from the drop-down menu that 

appears. 

The 'WinCue Configuration' dialog box will then appear. 

Double left-click on the 'News Interfaces' item in the left list box. 

The 'AP ENPS' item will then appear under the 'News Interfaces' item. 

Left-click (select) the 'AP ENPS' item 

The 'AP ENPS' configuration property pages will then appear to the right of the list box. 

Left-click on the 'Other Settings' tab. 

Left-click on the 'Font' button. 
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3.2.16 Changing Font and/or Font Size: 

The following presumes that the 'Select Font' dialog box is currently visible, if it is not then go 

to 'Changing the Font and Font Size for prompting on WinCue'. 

To change the Font Size: 

Left-click (select) the new font size or use the arrow buttons on the right of the 'Font Size' box 

to select a new font size, a preview of the font is visible in the box at the bottom of the dialog 

box. 

To change the Font: 

Left-click (select) the new font that you want to use in the 'Available Fonts' list box, a 

preview of the font is visible in the box at the bottom of the dialog box. 

If you are happy with your new Font and/or Font Size, left-click on the 'OK' button. 

If you are not happy and do not want to use your new Font and/or Font Size, left-click on 

the 'CANCEL' button.  

 

3.2.17 Dumping an ENPS Runorder to WinCue 
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Go to the ENPS terminal that is designated as one that can 'Dump to WinCue'. If the 

terminal is capable of dumping an ENPS runorder to WinCue the menu item 'Dump to 

WinCue' will be visible on the open runorders 'Rover' button (the top-left green button on 

the ENPS Runorder) menu. 

First step 

If the ENPS Runorder you require is not currently open: 

Open the ENPS Runorder that you want to be sent to the prompter by double left-clicking on 

the runorders name (e.g. NEWS WEST 1330 28th May) in the current runorder list. The 

selected runorder will then be opened and all of its stories will be listed, though only a few 

may be immediately visible. 

Second step 

If the ENPS Runorder you require is currently open: 

Left-click on the open runorders 'Rover' button (the top-left green button on the ENPS 

Runorder), a drop-down menu will now be displayed. 

One of the options on the menu is 'Dump to WinCue'; left-click on this option to select it and 

enable the 'Dump', when enabled a tick mark will be placed next to this menu option. 

Third step 

Within a few seconds of 'Dumping to WinCue' the selected ENPS Runorders title will be 

displayed in the WinCue terminals 'Runorder/Queue Browser' (see  'Opening an ENPS 

Runorder on WinCue') 

Once the 'Dump' has been enabled the ENPS terminal will continually update the WinCue 

terminal with any changes to the ENPS Runorder and the stories within it up until someone 

disables the 'Dump' or closes the runorder on the ENPS terminal. 

You can check whether the 'Dump' has been enabled by left-clicking on the ENPS 

Runorders 'Rover' button, a tick mark next to the 'Dump to WinCue' option indicates that 

the 'Dump'/link is still enabled. 

The 'Dump' can be disabled by selecting the 'Dump to WinCue' option again. 
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3.3 WinCue BASYS 

3.3.1 Setting up WinCue to access BASYS Runorders 

DESCRIPTION OF SET UP STILL TO BEING WRITTEN, PLEASE CONTACT 

TECHNICAL SUPPORT FOR ANY INQUIRIES. 

3.3.2 Starting WinCue BASYS 

NOTE: It should never be necessary for a user to start WinCue, as the program should 

never be exited. 

If the computer is not logged in and is displaying the 'Press Ctrl + Alt + Delete to log on': 

Do as instructed and hold down 'Ctrl-Alt-Delete'. 

A new message will now be displayed asking for a 'User name' and 'Password'. 

Enter the 'User name' which is usually 'Operator'. 

Enter the 'Password' which is usually 'QTV' (all in lowercase). 

The logging in procedure will automatically run WinCue. Now go to 'Start receiving BASYS 

downloads'. 

If WinCue is not currently running: 

Double-click with the mouse on the 'WinCue' icon displayed on the screen.  
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3.3.3 Start receiving BASYS downloads on WinCue 

IMPORTANT: The 'Start Receiving Downloads' must be activated before WinCue can 

receive any downloads from BASYS. 

How to ensure that 'Start Receiving Downloads' is activated: 

Left-click on the 'File' menu, a drop-down menu will appear. Two of the listed options are 

'Start Receiving Downloads' and 'Stop Receiving Downloads'. 

If 'Start Receiving Downloads' has been activated then 'Stop Receiving Downloads' will be 

the only option out of the two that is selectable (not grayed out). 

This means that WinCue is ready to receive BASYS downloads:  

If 'Start Receiving Downloads' has not been activated then 'Start Receiving Downloads' 

will be the only option out of the two that is selectable (not grayed out), to activate 'Start 

Receiving Downloads' select (left-click) on the 'Start Receiving Downloads' menu option. 

If you are unsure if the 'Start Receiving Downloads' has been activated, then you can select 

(left-click) the option just to be sure. 

IMPORTANT: Once WinCue has finished receiving the initial BASYS download you 

must press the 'RESET R.O.' button on the WinCue multibutton scroll control. This will 

set the prompt to the top of the running order. 
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NOTE: In most cases it should never be necessary to select 'Stop Receiving 

Downloads' as this will deactivate the 'Start Receiving Downloads'preventing WinCue 

from receiving BASYS downloads. 

3.3.4 Closing a BASYS runorder on WinCue 

Close a runorder by left-clicking on the lower of the two 'X's in the top-right of the screen.  

A message box will appear if you are currently prompting the runorder. It will ask if you are 

sure that you want to close it, select 'Yes' if you are sure. 

Once the BASYS runorder is closed, WinCue will be ready to receive the next download from 

BASYS. 

3.3.5 Stop receiving BASYS downloads 

NOTE: In most cases it should never be necessary to select 'Stop Receiving 

Downloads' as this will deactivate the 'Start Receiving Downloads' preventing WinCue 

from receiving BASYS downloads. 

How to 'Stop Receiving Downloads': 

Left-click on the 'File' menu, a drop-down menu will appear. Two of the listed options are 

'Start Receiving Downloads' and 'Stop Receiving Downloads'. 

If 'Start Receiving Downloads' has not been activated then 'Start Receiving Downloads' 

will be the only option out of the two that is selectable (not grayed out). 
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This means that WinCue is already set not to receive BASYS downloads: 

If 'Start Receiving Downloads' has been activated then 'Stop Receiving Downloads' will be 

the only option out of the two that is selectable (not grayed out). 

Select (left-click) on the 'Stop Receiving Downloads' menu option to prevent WinCue from 

receiving BASYS downloads, this action will also close any BASYS Runorders that you 

currently have open. 

3.3.6 Editing  a BASYS runorder and stories on WinCue 

NOTE: To 'select' a story in the runorder you can either left-click on the story or use 

the cursor keys and/or 'Page Up', 'Page Down' to move to the item. 

Moving a story on WinCue: 

Moving a runorder story in WinCue consists of dragging and dropping the story using the 

mouse. 

Left-click and hold down on the story that you wish to move in the runorder (the story will now 

be highlighted black), move the mouse (still holding the left button down) so that the pointer 

points at the story below where you want the story to be moved to, then de-press the mouse 

button.    

OR 

Select the story you wish to move, then hold down 'Alt' and use the up and down 

arrow/cursor keys to move the story up and down the runorder. 

Creating a new story on WinCue: 

Right-click on the story below the place where you want the new story inserted. From the 

drop-down menu select 'New', 'Single Column Script'. You will then be prompted for the new 

story's name (you must give it a name) and then its BASYS story number (filename on NP2). 

If BASYS downloads a story with the same number as this story, the story will be updated 

with the BASYS story and title. 

Deleting/dropping a story on WinCue: 
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Left-click (select) the story that you want to delete/drop and then press the 'Delete' key   

OR 

Right-click on the story you want to delete/drop. From the drop-down menu select 'Delete'. 

The story will then be removed from the runorder and will appear in the 'Trashcan' at the 

bottom of the screen. Story's can be retrieved from the 'Trashcan' by moving (dragging) them 

back into the runorder. 

Editing/viewing a story on WinCue: 

NOTE: The editor works in the similar way to a word processor. 

Double-click on the story in the runorder. 

OR 

Select the story in the runorder and press the 'Enter'/return key. 

To exit the editor and return to the runorder, press the 'Esc'/escape key. 

3.3.7 Prompting a BASYS runorder on WinCue 

Information displayed on the WinCue runorder: 

A yellow bar on the runorder indicates which story you are currently prompting, the 'prompt 

bar'. 

A black bar on the runorder indicates which story you have 'selected'. This can be done by 

left-clicking on with the mouse, this black bar can be ignored. 

Double left-click on a story to view the text of the story, use the far-right scroll bar to view 

more of the story. 

The runorder word count column displays the number of words in a story. If there are no 

words in a story its word count box will be coloured red to indicate that it may be worth 

querying the gallery why there is no text in the story. It is only worthwhile querying a story if 

you believe that there should be some text in the story. 

The runorder status column displays information about the status of a story. 
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If a stories status box is coloured red it indicates that the status information is relatively 

important and may be worth querying. 

The status messages and their meanings: 

Updated - The story has been updated/re-downloaded since the original BASYS download. 

The following message will appear in a red status box: 

MISSING - The runorder item/slug has been downloaded from BASYS but the corresponding 

story file has not been downloaded from BASYS. 

Likely cause: The story has not been downloaded yet, or the story may not contain any text 

on BASYS. 

3.3.8 Using the Scroll Controllers 

NOTE, IF YOU HAVE A MULTIBUTTON CONTROL WITH OR WITHOUT A FOOT 

CONTROL: 

The button on the back of the Multibutton Hand Control switches between whether the 

Multibuttons scroll knob or the attached Foot Controls (NB. A Foot Controller may not be 

attached) pedal is to control the scrolling. 

If the button is OUT then the scrolling is controlled by the Multibuttons scroll knob. 

If the button is IN then the scrolling is controlled by the Foot Controls pedal. 

3.3.9 Using the Multibutton Hand Control to prompt 

The Multibutton Hand Control has twelve buttons and a scroll knob on its right hand side. The 

scroll speed is controlled by turning the knob. The functions of all the buttons on the 

Multibutton are listed below: 

Top row of buttons (left to right): 

FWD  Change the scroll direction. The scroll direction is indicated by the cue   

REV  marker on the prompt output. If the cue marker points in towards the story,  

you are scrolling forwards. 
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NEXT  Jump the prompt forward to the next story. (an ITEM is a STORY) 

ITEM 

PREV  Jump the prompt back to the previous story. 

ITEM 

RESET  Reset the prompt back to the start of the current story. 

ITEM 

Middle row of buttons (left to right): 

NEXT  Same function as NEXT ITEM. 

MARKER 

PREV  Same function as PREV ITEM. 

MARKER 

RESET  Reset the prompt back to the start of the current runorder. 

R.O.  Must be pressed after receiving the initial BASYS download. 

BLANK    Blanks/Un-blanks the prompt output. (Useful if you feel an interviewer may 

SCREEN  be put off by prompt on the camera) 

Bottom row of buttons (left to right): 

CAPTION  No assigned function for the BASYS Interface. 

ON/OFF 

2nd from left, Known as the  'CUE STORY' button, it will move the prompt back to the 

bottom row. very end of the previous story. This is useful to ensure that you are not pre- 

empting the gallery as to which is the next story to prompt. Yet you are still 

able to display enough of the next story for the presenter to start reading it. It 

is only worth using this button if BASYS controls the runorder. 
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CLEAR  No assigned function for the BASYS Interface. 

DECODER 

3.3.10 STOP Stop/Re-start the prompt scrolling. 

Using the Foot Control to prompt 

The scroll speed is controlled by increasing and decreasing the pressure applied to the foot 

pedal (much like a car accelerator pedal). The red button on the foot control changes the 

scroll direction in the same way as the Multibutton controllers FWD REV button. 

If the Foot Control is attached to the back of a Multibutton Hand Control then the Foot Control 

can be used in combination with the Multibutton Controls buttons. 

3.3.11 Using WinCue to select the next story to prompt: 

If it is necessary to jump the prompt to a story that is not the next or previous story in the 

runorder then you can use any of the following three methods. 

1: Hold down the left 'Alt' key and double left-click on the story you want to start 

prompting. 

2: Right-click on the story you want to start prompting, then select 'Prompt From 

Here' from the drop-down menu that appears. 

3: Left-click on the story you want to start prompting, this will select the story (shown 

by the black bar), then hold down the left 'Alt' key and press the 'Return' or 'Enter' key. 

After using any one of these methods, the prompt and the WinCue prompt (yellow) bar will 

move/jump to the chosen story. 

3.3.12 Changing the Font and Font Size for prompting  on WinCue 

Changing the Font and Font Size only for the current runorder: 

To change the font or font size for just the current runorder you must do the following: 

NOTE: If you want the new Font and Font Size to affect the current runorder and the 

default for all BASYS Runorders you should place a tick (by left clicking on the box) in 
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the 'Save as default' tick box on the 'ADR Rundown Properties' dialog boxes 'General' 

page. 

Left-click on the 'File' menu and then select 'Properties' from the drop-down menu that 

appears. 

The 'ADR Rundown Properties' dialog box will then appear, the 'General' page will be 

automatically displayed. 

Left-click on the 'Font' button. 

Now go to 'Changing Font and/or Font Size' on the next page. 

3.3.13 Changing the Font and Font Size of the default font setting affecting all runorders 

To change the default font or font size for all BASYS Runorders you must do the following: 

Left-click on the 'Tools' menu and then select 'Options...' from the drop-down menu that 

appears. 

The 'WinCue Configuration' dialog box will then appear. 

Double left-click on the 'News Interfaces' item in the left list box. 

The 'BASYS Download' item will then appear under the 'News Interfaces' item. 

Left-click (select) the 'BASYS Download' item 

The 'BASYS Download' configuration property pages will then appear to the right of the list 

box. 
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Left-click on the 'General' tab. 

Left-click on the 'Font' button. 

Now go to 'Changing Font and/or Font Size' below. 

3.3.14 Changing Font and/or Font Size 

The following presumes that the 'Select Font' dialog box is currently visible, if it is not then go 

to page 8, 'Changing the Font and Font Size for prompting on WinCue'. 

To change the Font Size: 

Left-click (select) the new font size or use the arrow buttons on the right of the 'Font Size' 

box to select a new font size, a preview of the font is visible in the box at the bottom of the 

dialog box. 

To change the Font: 

Left-click (select) the new font that you want to use in the 'Available Fonts' list box, a 

preview of the font is visible in the box at the bottom of the dialog box. 

If you are happy with your new Font and/or Font Size, left-click on the 'OK' button. 

If you are not happy and do not want to use your new Font and/or Font Size, left-click on the 

'CANCEL' button. 
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3.4 WinCueProNewsmaker. 

 

3.4.1 Setting up WinCue to access NewsMaker Runorders 

IMPORTANT: The WinCue computer must be able to access the NewsMaker 

queue folder directories. 

 

Left-click on the 'Tools' menu and then select 'Options...' from the drop-down menu 

that appears. 

The 'WinCue Configuration' dialog box will then appear. 

Double left-click on the 'News Interfaces' item in the right list box. 

The 'NewsMaker' item will then appear under the 'News Interfaces' item. 

Left-click (select) the 'NewsMaker' item 

The 'NewsMaker' configuration property pages will then appear to the left of the list box. 
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The 'Servers' property page is displayed. 

Left-click on the 'Add' button. 

The 'Modify NewsMaker Server' dialog box is now displayed.  

 

Enter a 'Name' for the server, this is a name used for reference purposes within WinCue 

for these settings and therefore doesn't have to be the servers computer name. (e.g. 

Name: NewsMaker One) 

Enter a 'Description' for the server, this is a description used for reference purposes 

within WinCue for these settings. (e.g. Description: Daily NewsMaker Runorders) 
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Enter a 'Path' for the server, this is the fully qualified network path for the NewsMaker 

‘NEN’ directory (e.g. \\SERVER1\NEWS\NEN). It may be easier to use the 'Browse' 

button to help find the NewsMaker directory. 

Once all this server information has been entered, left-click on the 'OK' button, the 

server name will now be listed under 'Configured Servers'. 

Now left-click on the 'Other Settings' tab. 

It is advisable to modify the 'Maximum Trashcan Size' from 50 to 250. 

Left-click on the 'Font' button, a font selection dialog will now be displayed, this is the 

font to be used for prompting, a font size of between 80 and 100 is advisable. 

Once you have finished selecting a font, left-click on the 'Code Page' tab, select the 

code page that is used by NewsMaker. 

When you are happy with your 'NewsMaker' settings, left-click on the 'WinCue Configuration' 

dialogs 'OK' button, this will save your settings. 

3.4.2 Setting up WinCue to display NewsMaker Runorders 

 

Left-click on the 'Tools' menu and then select 'Options...' from the drop-down menu 

that appears. 

The 'WinCue Configuration' dialog box will then appear. 

Left-click on the 'User Preferences' item in the right list box. 
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The 'User Preferences' configuration property pages will then appear to the left of  

the list box.  

Set all the options for the 'User Interface' the same as in the above screen shot. 
 
Now, left-click on the 'Windows' tab. 

 

Set all the options for the 'Windows' the same as in the above screen shot. 
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Now, left-click on the 'Prompt Tracking' tab. 
 

 

Set all the options for the 'Prompt Tracking' the same as in the above screen shot. 
 
When you are happy with your 'User Preferences' settings, left-click on the 'WinCue 

Configuration' dialogs 'OK' button, this will save your settings. 

NOTE: It is now advisable to close down the WinCue program and re-start it. 
 
 
If you have successfully completed all the above then you are now ready to open a 

NewsMaker runorder and prompt it. 

 

3.4.3 Starting WinCueProNewsMaker 

NOTE: This manual assumes that you have set up WinCue to work with 

NewsMaker using the 'WinCue with NewsMaker' set up guide. 

 

If WinCue is not currently running: 

Double-click with the mouse on the 'WinCue' icon displayed on the screen.  

The 'Runorder/Queue Browser' will automatically be displayed once WinCue is 

running. 

Now go to 'Opening a NewsMaker Runorder on WinCue'. 
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3.4.4 Opening a NewsMaker Runorder on WinCue 

First ensure the 'Runorder/Queue Browser' is open: 

 

NOTE: WinCue should only ever be in one of two states, either the 

'Runorder/Queue Browser' is displayed or a 'NewsMaker Runorder' (list of stories) 

is displayed. 

 

If WinCue is running but nothing is displayed (i.e. neither the 'Runorder/Queue 

Browser' or a NewsMaker Runorder is displayed): 

 

Left-click on the red toolbar icon which looks like a folder. 

Or 

Left-click on the 'File' menu and then select 'Open Queue' from the drop-down  

menu. 

 

The 'Runorder/Queue Browser' will then be displayed. 

If a 'NewsMaker Runorder' is currently displayed (a list of runorder stories): 

Close the runorder by left-clicking on the lower of the two 'X's in the top-right of  

the screen, or clicking on 'Close' under the 'File' menu.  
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A message box will appear if you are currently prompting this runorder. It will ask if you 

if you are sure you want to close it, select 'Yes' if you are sure. Once all the open 

runorders are closed, the 'Runorder/Queue Browser' will automatically be displayed. 

 

The 'Runorder/Queue Browser': 

 

 

From this box it is possible to access all the available NewsMaker Runorders. If the 

runorder that you wish to load (for prompting) is not listed in this box then you may need 

to navigate through the folders (directories) to find the folder containing the runorder you 

require. 

 

To open a NewsMaker Runorder on WinCue ready for prompting, do either of the 

following: 

Double left-click on the runorder that you want to open. 

Or 

Left-click (select) the runorder you want to open and then click on the 'OK' button. 

The runorder will then be opened and be set ready to start prompting.  

(see 'Prompting a NewsMaker Runorder on WinCue'). 

 

3.4.5 Closing a NewsMaker Runorder on WinCue 

Close a runorder by left-clicking on the lower of the two 'X's in the top-right of the 

screen, or clicking on 'Close' under the 'File' menu. 
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A message box will appear if you are currently prompting the runorder. It will ask if you 

are sure that you want to close it, select 'Yes' if you are sure. 

Once all the open runorders are closed, the 'Runorder/Queue Browser' will 

automatically be displayed, if this is not so then go to 'Opening a NewsMaker 

Runorder on WinCue'. 

 

3.4.6 Prompting a NewsMaker Runorder on WinCue 

NOTE: A NewsMaker Runorder should be prompted from start to finish in listed 

order (i.e. The prompt operator is not required to jump back and forth within a 

runorder. The runorder should be re-ordered using NewsMaker.) 

 

SAFE PRACTICE: Due to the way in which NewsMaker updates the prompter 

automatically it is necessary that if the prompting between two stories is not 

continuous (e.g. The prompt is stopped at the end of a story while a video clip is 

played (VT)) the prompt operator does not pre-empt the gallery by prompting into 

what they believe to be the next story to be prompted. 

 

Information displayed on the WinCue runorder: 

 

A yellow bar on the runorder indicates which story you are currently prompting, the 

'prompt bar'. 

 

A black bar on the runorder indicates which story you have 'selected'. This can be 

done by left-clicking on with the mouse, this black bar can be ignored. 

 

Double left-click on a story to view the text of the story, use the far-right scroll bar to 

view more of the story. 

The runorder word count column displays the number of words in a story. If there are 

no words in a story its word count box will be coloured red to indicate that it may be 

worth querying the gallery why there is no text in the story. It is only worthwhile querying 

a story if you believe that there should be some text in the story. 

 

The runorder status column displays information about the status of a story. 

If a stories status box is coloured red it indicates that the status information is relatively 

important and may be worth querying. 
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The various status messages and their meanings: 

The following two messages will appear in red status boxes as they are generally error 

messages. 

IMPORT FAILED - The story file has been read but it has not been possible for WinCue 

to import the text. 

Likely cause: The file may have been corrupted in some way. 

 

DATA OUT OF DATA - The story file has already been successfully imported by 

WinCue, but the subsequent update of the story has been read but it has not been 

possible for WinCue to import the text. 

Likely cause: The file may have been corrupted in some way. 

 

 

3.4.7 Using the Scroll Controllers: 

 

NOTE, IF YOU HAVE A MULTIBUTTON CONTROL WITH OR WITHOUT A FOOT 
CONTROL: 

The button on the back of the Multibutton Hand Control switches between 

whether the Multibuttons scroll knob or the attached Foot Controls (NB. A Foot 

Controller may not be attached) pedal is to control the scrolling. 

If the button is OUT then the scrolling is controlled by the Multibuttons scroll 

knob. 

If the button is IN then the scrolling is controlled by the Foot Controls pedal. 

 

 

 

Using the Multibutton Hand Control to prompt 
 

The Multibutton Hand Control has twelve buttons and a scroll knob on its right hand 

side. The scroll speed is controlled by turning the knob. The functions of all the buttons 

on the Multibutton are listed below: 

 

Top row of buttons (left to right): 

 

FWD  Change the scroll direction. The scroll direction is indicated by the cue 
REV  marker on the prompt output. If the cue marker points in towards the  

story, you are scrolling forwards. 
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NEXT  Jump the prompt forward to the next story. (an ITEM is a STORY) 
ITEM 

 

PREV  Jump the prompt back to the previous story. 
ITEM 

 

RESET  Reset the prompt back to the start of the current story. 
ITEM 

 

Middle row of buttons (left to right): 

 

NEXT  Same function as NEXT ITEM. 
MARKER 

 

PREV  Same function as PREV ITEM. 
MARKER 

 

RESET  Reset the prompt back to the start of the current runorder. 
R.O. 

 

BLANK  Blanks/Un-blanks the prompt output. (Useful if you feel an interviewer 
SCREEN may be put off by prompt on the camera) 
 

Bottom row of buttons (left to right): 

 

CAPTION  Dependant on whether you are using WinCue for Captioning. 
ON/OFF 

2nd from left, Known as the  'CUE STORY' button, it will move the prompt back to the 

bottom row. very end of the previous story. This is useful to ensure that you are not  

pre-empting the gallery as to which is the next story to prompt. Yet you 

are still able to display enough of the next story for the presenter to start 

reading it. 

 
CLEAR  Dependant on whether you are using WinCue for Captioning. 
DECODER 

STOP  Stop/Re-start the prompt scrolling. 
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Using the Foot Control to prompt 

 

The scroll speed is controlled by increasing and decreasing the pressure applied to the 

foot pedal (much like a car accelerator pedal). The red button on the foot control 

changes the scroll direction in the same way as the Multibutton controllers FWD REV 

button. 

 

If the Foot Control is attached to the back of a Multibutton Hand Control then the Foot 

Control can be used in combination with the Multibutton Controls buttons. 

 

 

Using WinCue to select the next story to prompt: 

 

If it is necessary to jump the prompt to a story that is not the next or previous story in the 

runorder then you can use any of the following three methods. 

 

1: Hold down the left 'Alt' key and double left-click on the story you want to start 

prompting. 

2: Right-click on the story you want to start prompting, then select 'Prompt From 

Here' from the drop-down menu that appears. 

3: Left-click on the story you want to start prompting, this will select the story 

(shown by the black bar), then hold down the left 'Alt' key and press the 'Return' or 

'Enter' key. 

After using any one of these methods, the prompt and the WinCue prompt (yellow) bar 

will move/jump to the chosen story. 

 

 

3.4.8 Using 'Panic Mode' if NewsMaker stops working: 

 

WinCue has a 'Panic Mode' option that allows NewsMaker Runorders and stories to be 

manipulated from WinCue if the NewsMaker system stops working for any reason such 

as a network failure. 
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IMPORTANT: The 'Panic Mode' feature should only be used as a last resort. 

If 'Panic Mode' is enabled the WinCue terminal will stop trying to read updates 

from NewsMaker, as soon as 'Panic Mode' is disabled the WinCue terminal will re-

start trying to read updates from NewsMaker. 

 

NOTE: Any changes to the runorder and stories on WinCue while in 'Panic Mode' 

will be lost as soon as 'Panic Mode' is disabled. 

 

3.4.9 Enabling/Disabling 'Panic Mode': 

Left-click on the 'Panic Mode' icon on the tool bar at the top of the screen to toggle 

'Panic Mode'. When the button is shown as pressed in 'Panic Mode' is enabled, 

otherwise it is disabled: 

 Disabled  Enabled 

 

 While in 'Panic Mode': 

 

The runorder can be changed on WinCue by dragging and dropping stories with the 

mouse. 

To Delete/drop a story, left-click (select) the story and then press the 'Delete' key, the 

story will then be moved to the 'Trash Can' at the bottom of the screen (stories can be 

dragged back out of the 'Trash Can'). 

To Insert a New story, right-click below the placement for the new story. 

A drop-down menu will then appear, select 'New', then 'Single-column Script'. 

You will be asked for the name/title of the new story, type it in and select the 'OK' 

button. 

Double-click on a story to view it and edit it. The editor works in a similar way to most 

Windows Word Processors. 

 

IMPORTANT: You must press the 'F7' function key after editing a story for it to be 

updated on the prompt output. 
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3.4.10 Changing the Font and Font Size for prompting  on WinCue 

 

Changing the Font and Font Size of the default font setting affecting all 
runorders: 
 
 
To change the default font or font size for all NewsMaker Runorders you must do the 

following: 

Left-click on the 'Tools' menu and then select 'Options...' from the drop-down menu 

that appears. 

The 'WinCue Configuration' dialog box will then appear. 

Double left-click on the 'News Interfaces' item in the right list box. 

The 'NewsMaker' item will then appear under the 'News Interfaces' item. 

Left-click (select) the 'NewsMaker' item. 

The 'NewsMaker' configuration property pages will then appear to the left of the list box. 

Left-click on the 'Other Settings' tab. 

Left-click on the 'Font' button. 

Now go to 'Changing Font and/or Font Size' on the next page. 
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3.4.11 Changing Font and/or Font Size: 

 

The following presumes that the 'Select Font' dialog box is currently visible, if it is not 

then go to 'Changing the Font and Font Size for prompting on WinCue'. 

 

To change the Font Size: 

Left-click (select) the new font size or use the arrow buttons on the right of the 'Font 

Size' box to select a new font size, a preview of the font is visible in the box at the 

bottom of the dialog box. 

 

To change the Font: 

Left-click (select) the new font that you want to use in the 'Available Fonts' list box, a 

preview of the font is visible in the box at the bottom of the dialog box. 

 

If you are happy with your new Font and/or Font Size, left-click on the 'OK' button. 

 

If you are not happy and do not want to use your new Font and/or Font Size,  

left-click on the 'CANCEL' button. 
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Getting Started with WinCueProNews 

 

In this chapter we explore the basic commands and functions you will need to know to begin working with 

WinCueProNews. We will describe how to use WinCueProNews in four simple steps and start prompting. 

By the end of this Chapter you will be able to create scripts and prompt them using WinCueProNews. 

4    WinCueProNews Basics 

 

4.1 Starting WinCueProNews 

The first step is starting WinCueProNews. Normally, you start WinCueProNews from within 

Windows by double clicking on the WinCueProNews icon. When WinCueProNews has 

loaded the WinCueProNews Client window appears. All script editing work is carried out here 

WinCueProNews can also be found under the Programs in the WinCueProNews 

Applications folder.  

 

Chapter

4
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4.2 Creating a New Script 

The WinCueProNews Client window is displayed when WinCueProNews is loaded. All script 

editing work is carried out here. 

To create a new script, use the New File icon on the toolbar. The New File icon looks like 
this:  

Or, choose File then New…from the menu. In both cases, a dialogue box Select New File 

Type will appear. Select Simple Script File from the list and click OK.  

A window called Untitled Simple Script File will appear inside the WinCueProNews Client 

window. 

To create your script just start typing 
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The cursor is automatically placed on left hand side of the Script Editor window. The text, 

which is written in the window, will appear on the prompter’s output. To add text to this 

window, just start typing. When the text reaches the right hand margin, WinCueProNews 

automatically “wraps” the following text to the next line. 

The blinking insertion point indicates where the text you type will appear. If you want to work 

in a different location in a document, you need to move the insertion point. To do this, use the 

mouse to move the I-beam to the new location, and then click.  

4.2.1 Adding Markers to a Script 

When prompting it is sometimes useful to be able to jump to specific parts of a script without 

having to scroll to that point. Markers are placed at points where the operator may need to 

jump too. 

To insert a marker, place the cursor in the position in the text where the marker is required. 

Choose Insert then Marker from the menu. A flag marker is inserted in text. 

 

Marker Flag 

See also 

Turn to section 4.4.2 to find out how to use the scroll control to move around the 

script using markers. 
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4.2.2 Adding Presenter Name to a Script 

To add a presenter name to the script select File, then Properties…. The Simple Script File 

Properties dialogue box will be displayed. Click on the Presenters tabs. To add a new 

presenter click on Add. 

The Presenter Properties dialogue box appears. Enter the presenters name in the 

Presenter Name text box and click OK. The presenters name will then be shown in the 

Currently Defined Presenters dialogue box. Click OK to exit. 

 

To add the name of the presenter to your script. Select the position for the label in the text 

and choose Insert then Presenter from the menu. The Select Presenter dialogue box will 

appear. 

Click on the presenter name you wish to insert, then click OK 
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4.2.3 Printing a Script 

To print your scripts choose File then Print… from the menu. The Print dialogue box 

appears.  

Choose the number of copies and ensure the script is selected in the Print Layout Name 

text box. Select OK to print. 

 

4.3 Saving Your Work 

It is good practice to save your work regularly while writing your script just in case there is a 

problem with the PC. 

Saving a Script for the First Time: 

To save a script for the first time, choose File then Save from the menu. The Save As 

dialogue box appears. Type in a name, which briefly describes your script in the File name 

text box and click on the Save button. 

 

Print icon 

Save icon 
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4.3.1 Saving Changes 

To save changes made to a script choose File then Save from the menu. The script changes 

will be added to the existing saved File. 

 

4.4 Prompting a Script 

Once you have finished typing your script, now its time to prompt it. 

4.4.1 Beginning a Prompting Session 

When you are ready to prompt your script choose Prompt then Begin Prompting from the 

menu. The first few lines of your script will appear on the prompter’s screen. Use the Scroll 

control attached to your computer to prompt the text. 

 

 

 

 

 

 

 

Begin Prompting 
icon 
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When prompting the Word Count box and Time box will turn yellow. 

 

4.4.2 IMT Scroll Control 

The two button serial control allows you to scroll the text up and down the screen and jump 

between markers. 

To scroll the text turn the knob at the end clockwise to speed up and anticlockwise to slow 

down. 

To change the direction of the prompted text press the black button. 

To jump to the next marker press the red button. 

4.4.3 Ending a Prompting Session 

 
When you have finished prompting your script choose Prompt then Stop Prompting from 

the menu. This will clear the prompter’s screen. 

 

Stop Prompting 
icon 
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4.4.4 Controlling Prompt and Edit Positions 

An important feature of WinCueProNews is the ability to control the relationship between the 

prompt output and the edit screen. The different options and functions are described below. 

In Script Lock Mode, the prompt output is prevented from scrolling and is tied to the edit 

screen. Any changes made on the edit screen are immediately reflected on the prompter, 

and if you move around in the editor, the prompt output will follow. Use Prompt, then Script 

Lock Mode (or Ctrl F11) to enable this way of working. A tick (����) will appear next to the 

menu option to show that the mode is active. Use the same command to return to normal 

operation. 

If Script Lock Mode is not in use, you can force the prompter to jump to the current edit 

position by using Prompt, then Jump prompt to editor (or Shift F11). Alternatively, you can 

make the editor jump to the same position as the prompter by using Prompt, then Edit at 

Prompt Position (or F11). 

It is also possible to make the editor catch up with the current prompt position every time 

scrolling is stopped. Choose Tools, Options to get to WinCueProNews Configuration. Click 

on User Preferences from the list of options, then click the Prompt Tracking tab. If the Auto 

Jump to Editor on speed zero option is ticked, the editor will keep catching up with the 

prompt output. There are two other options on this preference page, both related to behaviour 

while prompting with a WinCueProNews running order (not applicable to WinCueProNews 

LT). The Auto Follow On Prompt Item option will force the edit script to change each time 

the prompter moves to a new item. Keep On Prompt Item Visible In List will automatically 

move the running order so that the item currently being prompted is always visible on the 

screen.  

Used together, these functions and configuration options can allow the operator to work in 

very different ways. At one extreme, you could be editing part of a script which is at the other 

end of the show from what is currently being prompted, with no interference between the two. 

Alternatively, by locking the prompter to the editor, the presenter can see every change that 

you make.  
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4.5 Getting Started in WinCueProNews Summary 

To Do this Button 

Start WinCueProNews Click on the WinCueProNews icon 

 

Create a new script On the File menu, open Untitled 

Simple Script File 
 

Add markers to a script On the Insert menu, click on 

Marker command 

 

Add presenter to script On the File menu, click on 

Properties command. Click on 

presenter tab, then Add, enter 

presenter name in dialogue box and 

click OK 

On the Insert Menu, click on 

Presenter, select presenter name 

and click OK 

 

Print a script On the File menu, click the Print 

command  

Save a script On the File menu, click the Save 

command 
 

Prompt a script On the Prompt menu, click the 

Begin Prompting command 
 

 On the Prompt menu, click the 

Stop Prompting command 
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WinCueProNews Script Editor 
 

In this Chapter you will learn how the script editor works. The Script Editor is used to create the prompting 

text and is similar to many Windows based editors. Therefore, if you have used Windows based word 

processors commands will be familiar. At the end of this chapter you will be able to set read rates, fonts, 

colours and styles to suit individual presenters, and also change the editors layout to suit the way you 

work. This chapter applies to all versions of WinCueProNews. 

5    The Script Editor 

 

5.1 The Script Editor Window 

The Script editor is used to create the scripts. The Script Editor window has three main 

features. 

5.1.1 The Script Window 

The script is created in this window and this represents what will be seen when 

WinCueProNews is in the prompt mode. The text is written white on a black background. 

WinCueProNews supports both mouse and keyboard controls. A summary of the shortcut 

keyboard controls is shown below. These keystrokes will help you to move around the editor 

quickly. The cursor can be moved anywhere in the script using the cursor keys or the mouse. 

Text can be deleted using the Backspace and delete keys or by highlighting the desired text 

and pressing the delete key. 

 

Chapter

5



WINCUEPRONEWS USER GUIDE 

VERSION 1.30B515 90  QTV 1998 

Key To move 

HOME To the beginning of a line 

END To the end of a line 

Page Up Up one screen 

Page down Down one screen 

Ctrl + HOME To the beginning of the script 

Ctrl + END To the end of the script 

 

5.1.2 The Word Count Boxes 

As you type a script WinCueProNews will keep track of the number of words in the script. The 

current word count appears in the Total Words box and is constantly updated. 

WinCueProNews also displays the number of words to the end of the script from the position 

of the cursor within the script. The number of words to the end of the script is displayed in the 

Words To End box. 

5.1.3 The Script Duration Boxes 

The time taken for a person to read a script from the prompter screen will depend on the 

number of words in the script and how fast that person reads. WinCueProNews uses the 

current word count and the presenters read rate to calculate the duration of the script. The 

script duration in seconds is displayed in the Total Time box and this is also constantly 

updated. 

The default read rate of 180 words per minute is used if the read rate is unknown. 

WinCueProNews also displays the time to the end of the script from the position of the cursor 

within the script. This is calculated in the same way as the Total Time. The time to the end of 

the script is displayed in the Time To End box. 
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5.2 Changing the Script Characteristics 

The following sections give general information about formatting scripts to suit individual 

preferences. 

5.2.1 Changing the Font 

You may wish to change the font of a script to suit individual presenters for example. 

Choose Format, then Font from the menu. A dialogue box Select Font will appear. Click on 

font required in the Available Fonts list and the sample box will give you a preview of your 

selection. Use the Font Size text box to set the font to an appropriate size. When you are 

happy with the font setting click on OK. 

 

 

5.2.2 Changing the Font Style 

Changing the style of the characters or words within a script can help them to stand out from 

the main body of the text. The styles available to any font are bold, italic and underline. 

Choose Format, then the style you want to use (Bold, Underline or Italic) from the menu. 

When you begin typing the characters will appear in the style you selected. 

 

 

There are also shortcut keyboard controls as shown in the table. 

Key To change style 

Ctrl + B To bold 

Ctrl + U To underline 

Ctrl + I To italic 

Toolbar 
Click on the style buttons on the toolbar: 

   
Bold Underline Italic 

Toolbar 
When you have highlighted the text click on the font icon: 
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5.2.3 Changing the Colour of the Text 

In addition to changing the style of characters in a script, you can also change their colour.  

Choose Format, then Colour from the menu. A sub menu appears and from this you can 

select the colour required. When you begin typing the characters will appear in the colour you 

selected. 

 

 

 

There are also shortcut keyboard controls as shown in the table. 

Key To colour change  

Ctrl + 0 Default* 

Ctrl + 1 Red 

Ctrl + 2 Green 

Ctrl + 3 Blue 

Ctrl + 4 Yellow 

 

 

5.2.4 Inverting the Background Colour and the Text 

The background colour of the text can be changed in WinCueProNews. The default colour is 

a black background with the characters in white. Using the Inverse function the characters will 

be black on a white background. For another example, if the characters are blue with a black 

background, when the inverse function is used the characters will be black on a blue 

background. 

* The Default colour is usually white characters on a black background. If 

Inverse is selected the characters will be black. 

Toolbar 
Click on the colour buttons on the toolbar: 
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Choose Format, then Inverse from the menu. When inverse is selected it will have a check 

mark (����) in the menu. 

 

 

 

There are also shortcut keyboard controls as shown in the table. 

Key To inverse 

Ctrl + E Text and background colours 

 

5.2.5 Justifying the Text 

WinCueProNews supports both left and right justified text in the script window. To change the 

justification of text, choose Format then Justification from the menu. A sub menu appears 

and from this you can select either Left or Right. Once selected it will have a check mark (����) 

against it. When you begin typing the text will be justified according to your selection. 

 

 

 

There are also shortcut keyboard controls as shown in the table. 

Key To justify 

Ctrl + Alt + L Left 

Ctrl + Alt + R Right 

Toolbar 
When you have highlighted the text click on the inverse button: 

 
 

Toolbar 
Click on the justify buttons on the toolbar: 
 

     
Left  Centre  Right 
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5.2.6 Highlighting Text in the Editor 

You may want to select text from within a script and change that in some way, such as 

deleting, copying or changing font. Therefore in order to do this you must first select the text 

by highlighting it. You can highlight using the mouse or keyboard. There are also shortcut 

keyboard controls as shown in the table. 

Key To Highlight 

Shift + ���� One character to the right 

Shift + Ctrl + ���� To the end of a word 

Shift + Home To the beginning of a line 

Shift + End To the end of a line 

Shift + Page Up One screen up 

Shift + Page Down One screen down 

Shift + Ctrl + End To the end of a script 

Shift + Ctrl + Home To the beginning of a script 

Ctrl + A Highlight all text 

 

Once the text is highlighted you can then make any changes in format, copy or delete. 

5.2.7 Captions 

Those of you running WinCueProNews with a caption generator may want to select particular 

parts of the script that won’t be sent to the caption generator. Select the text by highlighting, 

and then choose Format, then Not Captioned from the menu. The marked text will not be 

sent to the caption generator. 
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5.2.8 Format All 

For simple formatting of the entire script choose Format then All text… from the menu. The 

Format All dialogue box will appear. To select Bold, Italic, Underline, Inverse simply press 

the button. To change the font press the Font button, a Select Font dialogue box will be 

displayed, choose your font and size. When your happy with your selection click OK. 

5.2.9 Not Prompted Text 

There may be text within your script that you don’t need to prompt. Select the text by 

highlighting, and then choose Format, then Not Prompted from the menu. This text will then 

not appear on the prompter’s output. 

5.2.10 Finding Words in a Script 

To search for a particular word in the current script, choose Edit, then Find, or just press 

Shift F3. A dialogue box will appear. Type the word you are looking for and click OK. 

WinCueProNews searches from the current cursor position to the bottom of the script. If it 

finds the word you specified, it will highlight it, otherwise it will ask if you want to continue 

searching from the top of the script. A warning will be displayed if the word is not found. You 

can search for the same word again by choosing Edit, then Find Next, or by pressing F3. 

5.2.11 Replacing Words in a Script 

To replace one or more words within the current script, choose Edit, then Replace. The 

Replace dialogue box will appear. Type the word or phrase you wish to find in the ‘Find what:’ 

box, and the word or phrase you want to replace it with in the ‘Replace with:’ box. Then use 

the Find Next and Replace buttons to control the replacements manually, or click the 

Replace All button to automatically make the changes. 

5.3 Creating Your Own Settings For New Scripts 

In this section we will explore how to set up WinCueProNews to produce all your new scripts 

in the format you want. 

5.3.1 Changing the Default Read Rate 

The read rate is defined as the number of words spoken in one minute. WinCueProNews 

uses the default read rate of 180. 

Note  
Items must be checked in the Presenter Settings before they can be modified. 

See section 5.4.4 
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To change the read rate choose File then Properties… from the menu. The Simple Script 

File Properties dialogue box appears. Click on the Presenter tab. To modify the default 

select Default and then Modify. The Attributes tab is then displayed. Select the Read Rate 

text box, type in the new value for the default read rate and click on OK to save your 

changes. Click OK to exit the Simple Script File Properties dialogue box. 

 

 

5.3.2 Changing the Default Font and Font Size 

WinCueProNews can prompt any font installed on your PC. You can change the font used for 

any new scripts you create by changing the default. 

To change the font choose File then Properties… from the menu. The Simple Script File 

Properties dialogue box appears. Click on the Presenter tab. To modify the default select 

Default and then Modify. The Attributes tab is then displayed. Select the Modify Font 

button. A dialogue box Select Font will appear. Click on font required in the Available Fonts 
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list and the sample box will give you a preview of your selection. Use the Font Size text box 

to set the font to an appropriate size. When you are happy with the font setting click on OK. 

 

5.4 Presenter settings 

Presenter’s settings allow you to customise settings for individual presenters. The font, 

colour, style and read rate can be allocated for individual presenters. These settings will be 

automatically applied to the script when the presenter is selected. 

5.4.3 Adding a New Presenter 

To add a presenter name to the script select File, then Properties…. The Simple Script File 

Properties dialogue box will be displayed. Click on the Presenters tabs. To add a new 

presenter, click on Add. The Presenter Properties dialogue box appears. Enter the 

presenter’s name in the Presenter Name text box and click OK. The presenters name will 

then be shown in the Currently Defined Presenters dialogue box. Click OK to exit. 
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5.4.4 Changing the Presenter Settings 

To change the read rate choose File then Properties… from the menu. The Simple Script 

File Properties dialogue box appears. Click on the Presenter Settings tab.  

If an attribute is checked (����) the setting becomes optional in the Presenters tab. This means 

you can choose to set that attribute for individual presenters. When you are happy with the 

setting click on OK. 

5.4.5 The Attributes Tab 

 

The Attributes tab contains all the settings for a presenter. They are as follows: 

�Presenter Name can be entered in this text box 

�Bold, Italic Underline styles are available. If a box is checked (����) that style will be used in 

the editor 

�Colour can be selected from sub menu. 
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�Inverse function can be enabled by checking box (����) 

�Read Rate is entered in the text box. 

 

Click on Modify Font button, the Select Font dialogue box is displayed. Use the Available 

Fonts list to select a font and the Font Size text box to set the font to an appropriate size. 

The Sample box will preview your selection. When you are happy with the font settings for 

your new presenter click on OK. 

When you are happy with all the settings in the Attributes tab for your new presenter click on 

OK. You are returned to the Presenter tab. Click on OK to close Simple Script File 

Properties dialogue box. 

5.4.6 Modifying a Presenter 

To modify presenter’s settings, choose File then Properties… from the menu. The Simple 

Script File Properties dialogue box appears. Click on the Presenter Settings tab.  

Select the presenter from the Currently Defined Presenters tab and then Modify. The 

Attributes tab is then displayed. Make any changes to the settings required and when you 

are happy with the settings, click on OK to save your changes. Click OK to exit the Simple 

Script File Properties dialogue box 

5.4.7 Deleting a Presenter 

To delete a presenter, choose File then Properties… from the menu. The Simple Script 

File Properties dialogue box appears. Click on the Presenter Settings tab.  

Select presenter from the list of Currently Defined Presenters and click on the Delete 

button to delete. Click on OK to exit. 

 

 

 
Warning 

If you delete a presenter name that is used by a script the presenter is removed 

from the script as are all his settings. The default settings are therefore used 

instead. 

An attribute that is set for a presenter cannot then subsequently be modified within 
the text 
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 WinCueProNews Rundowns 

 

In this chapter we learn how to create rundowns and work with a number of stories. By the end of this 

chapter you will be able to prompt using multiple rundowns. The chapter assumes the knowledge of the 

basics and the script editor. This Chapter does not apply to WinCueProNews LT. 

6    Working with Rundowns 

 

6.1 The WinCueProNews Rundown Window 

The WinCueProNews Rundown window consists of two parts, the WinCueProNews 

Rundown and the Script Editor. The rundown displays a list of the stories, which will be 

displayed for the presenter. The stories are then prompted in the order they appear in the 

rundown list. The Script editor is used to create the text attached to each of the stories. 

 

Chapter

6

See also 
Chapter 5 for more information on the script editor 
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6.1.1 Features of WinCueProNews Rundown 

This provide a brief overview of all the features most of which have been described in 

previous section. 

����ID this provides a unique number for all stories in the rundown and is not connected with 

the running order  

�Story Title simply a title to identify the individual stories 

����Words provide a word count of the number of words in the script displayed in the Script 

Editor. 

����Link this is the time for this script based on the set read rate. (Default read rate 180 words 

per minute). 

����Modified and 

 ����Status are used in WinCueProNews 

 

6.1.2 The Script Editor Window 

The Script Editor window displays the Story title at the top and below three text boxes. 

Firstly the ID number of the story is displayed in the first box labelled ID. Secondly the word 

count box which displays the number of words in the script, labelled Words. Finally the 

duration of the script based on the number of words and the set read rate is displayed in the 

box labelled Time. 

The Script editor is used to create the text of the script, which will be displayed on the 

prompter’s screen. 
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The size of the Script Editor window can be adjusted. As you move the pointer onto the left 

hand side of the frame the pointer changes shape. When the pointer changes shape click the 

mouse button and drag to the desired width. 

 

6.2 Creating a New Rundown 

6.2.3 Creating a New Story 

The first step in creating a new rundown is creating a new story. To create a new stories 

select Story, then New from the menu. A sub menu appears and from this you can select 

Single-column Script or Single-column Break. Choose Single-column Script and the 

New Item Title dialogue box appears. Enter the story name in the text box and click OK. The 

story name should be one or two word description of the story. 

A Single-column Break can be used to split the rundown into sections. The total times for 

each section can be displayed in the running order by the break item. 

Sizing Pointer 

II� 
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The title of the story will appear in WinCueProNews Rundown window under the Story 

Title heading. 

To attach text to the story using the Script Editor, double click on the line of the story in the 

WinCueProNews Rundown window. A black bar on the rundown order indicates the story 

you are currently prompting. The Story Title will be shown at the top of the Script Editor box. 

The cursor is automatically placed in the Script Editor window and you can type in the 

accompanying script to the story. The text written in the Script Editor will appear on the 

prompter’s output. 

To quit the Script Editor press the Esc (Escape) key on the keyboard. 

6.2.4 Adding a New Story to the Rundown 

Creating a new story adds a line to the rundown. The text for this item can be attached to this 

story using the script editor Choose Story, then New from the menu. A sub menu appears 

and from this you can select Single-column Script or Single-column Break. Choose 

Single-column Script and the New Item Title dialogue box appears. Enter the story name 

in the text box and click OK. 

6.2.5 Saving Scripts and Rundowns 

It is good practice to save the rundown and scripts regularly to ensure no information is lost 

accidentally. To save rundown and accompanying scripts, choose File, Save As from the 

menu. A Save As dialogue box will be displayed. Enter the name of the Rundown in File 

name text box and click on Save. 

To save changes made to a script choose File, Save from the menu. The script changes will 

be added to the existing file. 

6.2.6 Moving Stories Within the Running Order 

The stories within a rundown can be reordered very easily using the drag and drop facility in 

WinCueProNews. Drag-and–drop is the easiest way to move a story within a Rundown. 

Select the story you want to move by pointing to it and hold down the left-hand mouse button. 

When the drag and drop pointer appears, drag the dotted insertion point to the new location. 

Release the mouse button to drop the story in its new place in the runorder. 

A black bar on the rundown order indicates the story you have selected 

Drag-and-drop pointer 

 

Save icon 
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6.2.7 Renumbering Stories in the Rundown 

The stories within a rundown can be renumbered at any stage when lines are added or 

deleted. Choose Rundown, then Renumber from the menu. 

6.3 Editing Within the Rundown 

It is possible to edit the rundown and the attached stories in the rundown window. This will be 

quicker and often more convenient than the pulldown menus. To do this click once with the 

right mouse button on the story you wish to edit. A menu appears next to the cursor. This 

section describes the commands available from this menu. 

 

6.3.3 New story 

To add a new story to the rundown, click once with the right mouse button on the position in 

the rundown where you want it to appear. A sub menu appears next to the cursor. Select 

New from this menu, you can then select Single-column Script or Single-column Break. 

Choose Single-column Script and the New Item Title dialogue box appears. Enter the story 

name in the text box and click OK. 

6.3.4 Edit Story 

To do this click once with the right mouse button on the line you to view. A menu appears 

next to the cursor. Select Edit Story from this menu. The item can then be edited. 

The item can also be edited by selecting it from the rundown list and using the menu 

commands. Choose Story, then Edit from the menu.  
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Finally, you can edit the attached script by double left clicking on the story and the Script 

Editor window appears. 

6.3.5 View Story 

To do this click once with the right mouse button on the line you to view. A menu appears 

next to the cursor. Select View Story from this menu. Viewing the text allows you to read the 

text attached to a story and allows you to make changes to it.  

The item can also be edited by selecting it from the rundown list and using the menu 

commands. Choose Story, then View from the menu.  

Finally, you can view the attached script by double left clicking on the story and the Script 

Editor window appears. 

6.3.6 Delete Story 

It may be necessary to delete stories from the rundown. To do this click once with the right 

mouse button on the line you wish to delete. A menu appears next to the cursor. Select 

Delete from this menu. A dialogue box will appear Sure you want to delete this item? Click 

Yes to delete. The item will be deleted from the rundown and the text from the Script Editor. 

The item can also be deleted by selecting it from the rundown list and using the menu 

commands. Choose Story, then Delete from the menu. A Dialogue box Sure you want to 

delete this item? will appear. Click on Yes to delete. 

6.3.7 Deleting Multiple Stories 

It may be necessary to delete multiple stories from the rundown. This removes the 

highlighted lines and the attached text contained in the Script Editor. 

Hold the Ctrl key on the keyboard and click once on each of the stories you wish to delete 

from the Rundown. Choose Story, then Delete from the menu. A Dialogue box Sure you 

want to delete this item? will appear. Click on Yes to delete. 

Alternatively, hold the Ctrl key on the keyboard and click once on each of the stories you 

wish to delete from the Rundown. Click once on the right mouse button on any highlighted 

story. A menu appears next to the pointer. Choose Delete from the menu. A Dialogue box 

Sure you want to delete this item? will appear. Click on Yes to delete.7 
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6.3.8 Edit Field  

The unique title field in the rundown simply identifies each individual story. The title field 

should contain a one or two word description of the story. To do this click once with the right 

mouse button on the story you wish to edit. Choose Edit Field from the menu. The title field 

will now appear white indicating you can now edit. Make your changes and when you are 

happy click on the left-hand mouse button or press enter. 

If you have a three-button mouse it’s even simpler. Just click on the story you wish to edit with 

the middle mouse button 

To edit the field directly with a two button mouse press Ctrl and press the right hand button on 

the mouse to edit the field directly. 

6.3.9 Toggle Hold State 

Toggle Hold State allows you place an item in the rundown, which will not be prompted and 

will not be included in any timing calculations. This allows stories to be on standby. To do this 

click once with the right mouse button on the line you wish to hold. A menu appears next to 

the cursor. Select Toggle Hold State from this menu. The item selected turns blue.99 

6.3.10 Prompt From Here 

The Prompt From Here command allows you to begin prompting from anywhere within the 

rundown. To do this click once with the right mouse button on the line you wish to begin 

prompting at. A menu appears next to the cursor and select Prompt From Here from this 

menu. The rundown then goes into prompting mode and the item selected as the first turns 

yellow. 

6.4 Working with Multiple Rundowns 

WinCueProNews will allow the user to have a large number of rundowns and Script Editor 

windows open at the same time. However, to limit the confusion it is best to have only one 

open at a time. 

WinCueProNews provides a number of standard tools to help organise multiple rundown 

windows. The rundown windows currently opened are displayed on the window bar. 

Mouse Controls 
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6.4.1 Tiling windows 

The windows can be tiled this enables the operator to see part of all the rundowns on one 

screen. The way in which the windows are tiled depends on how many are open. 

If you wish to see only the Rundown windows, then close all the Script Editors windows. 

Choose Window, then Tile Horizontally or Tile Vertically from the menu. The tilling can be 

horizontal or vertical depending on what you prefer. To make a window active choose the 

corresponding Rundown name from the window and click on it. 

6.4.2 Cascading Windows 

Cascading windows arranges all the open windows one behind each other with their titles 

visible. The top window is the only one that can be seen complete. 

Once again if only the Rundowns are to be cascaded, close all the script editors. Choose 

Window, then Cascade from the menu. All the open windows are stacked so their titles are 

visible. 

To bring a chosen rundown to the front, choose click on the rundown name in the stack or 

click on title on the status bar. 

6.4.3 Arranging Icons 

All the open windows can be minimised to icons. These icons can become disorganised; 

Arrange places them in an orderly fashion. 

Choose Window, then Arrange from the menu. All the icons will be arranged in an orderly 

fashion at the bottom of the WinCueProNews window in the Status bar. 

6.4.4 Moving Stories Between Rundowns 

Stories can be moved between Rundowns very easily using the drag and drop facility in 

WinCueProNews. Drag-and–drop is the easiest way to move a story between Rundowns. 

Select the story you want to move by pointing to it and hold down the left-hand mouse button. 

When the drag and drop pointer appears, drag the dotted insertion point to the new location. 

Release the mouse button to drop the story in its new place in the Rundown. 
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6.5 Prompting Mode 

When WinCueProNews enters the prompting mode the stories in the chosen rundown can 

be scrolled. The prompter operator controls the speed at which the text is scrolled to suit the 

presenters read rate. The stories within a rundown can be skipped or returned as necessary. 

 

6.5.1 Entering Prompt Mode 

To start the prompter choose Prompt, then Begin Prompting from the menu. The first item 

on the rundown list appears yellow indicating that this is the current item prompting. The 

prompter operator can now control the text on the prompter using the scroll controller. 

 

6.5.2 Controlling Prompted Text 

The prompter operator uses the scroll controller to vary the text scroll speed, the direction, to 

skip backwards and forwards between stories in the rundown. There are a number of other 

options available, within the Prompt menu, when prompting. Choose Prompt, then any of the 

following from the menu: 

Edit at Prompt Position Allows editing at current position 

Script Lock Mode 
Stops prompting and set prompter at the 

beginning of current item 

Jump prompt to editor 
Skips to start of current item and continues 

prompting 

Refresh Prompt Output 
Skips back a couple of lines and continues 

prompting 

 

A check mark (�) indicates the command is on. 

6.5.3 Quitting Prompt Mode 

To quit the prompter, choose Prompt, then Stop Prompting from the menu. 

See Chapter 7 for details of the different scroll controllers and there set up 

A yellow bar on the rundown order indicates the story you have selected 
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Chapter 

7 
 

Scroll Controls 

 

In this chapter you will learn how the prompter works. You will find out about the various scroll controls, 

configuring the prompt output and editing while in prompt mode. 

7    The Prompter 

 

7.1 The IMT Scroll Control 

WinCueProNews is supplied with an I.M.T. scroll control as standard, which plugs in to the 

I.M.T. card. WinCueProNews also supports a number of other scroll controls, including an on 

screen one, which can be controlled using a mouse. 

 

There are a variety of scroll controls supported by WinCueProNews; you choose the one 

which best suits you needs. 

 

1. On-screen Scroll Control  

2. IMT Scroll Control 

3. Hybrid Serial IMT Multibutton Controller 

4. Foot Control  

 

7.2 Selecting a Scroll Control 

 
Choose Tools then Options… from the menu. Double click on Prompt Engine, then click 

on Scroll Controls. The Configure Scroll Controls dialogue box appears. Select the type of 

control you wish to use. 
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7.3 On-screen Scroll Control 

The On-Screen Scroll Panel enables you to prompt text using the mouse. In the event of 

your normal scroll control failing this is a convenient backup. 

 

The Scroll Control Panel features a speed control slide bar, which is used for varying the 

speed of the prompted text. Click on the left-hand button of the mouse and slide to operate. 

The slide bar has a centre stop position. When it is above the centre position text will be 

scrolled up the screen. When it is below the centre position the text scrolls down the screen. 

 

The Top of Queue button on the screen Scroll Control Panel changes the current prompt 

position to be the start of the script or rundown. 

 

The Top of Story button on the screen Scroll Control Panel changes the prompt position to 

the start of the current script being prompted. 

 

The Halt button on the screen Scroll Control Panel stops the prompted text. 
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7.4 IMT Scroll Control 

The I.M.T. scroll control is supplied with WinCueProNews and is connected to the I.M.T. card. 

This scroll control does not require any kind of configuration. 

 

Click on I.M.T. Card Scroll Port, then click on OK. You can how use the I.M.T. scroll control 

to prompt your scripts. 

 

 
 

The simple serial scroll control is connected to a free serial communication port. In Standard 

Configuration the simple serial scroll control allows you to scroll the prompted text up and 

down the screen and jump between markers.   

 

�To scroll the text, turn the knob at the end of the scroll control clockwise to speed up and 

anti clockwise to slow down.   

 

�To change the direction of the prompted text press the black button 

 

�To jump to the next marker press the red button  
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7.4.1 Configuring for Centre Stop Mode 

The IMT Scroll Control can be set up for Centre Stop mode. In the Configure Scroll 

Controls dialogue box, click on IMT Card Scroll Port. Now click on the Setup button to 

configure simple serial hand control. The Configure Scroll Control dialogue box appears. 

 

Ensure the Serial Port set to the same serial port that you simple serial scroll control is 

connected too. 

 

Centre Stop Mode is used if the operator does not want to use the forward reverse button to 

change the direction of the prompted text. To enable Centre Stop Mode, the Centre Stop 

Mode check box should be checked (����). Next the stop point and stop zone should be set. 

 

The simple serial scroll control sends serial data in the range 0 to 120 to tell WinCueProNews 

how fast to prompt the text; 0 is stop and 120 is the fastest scroll rate. This scroll rate is 

determined by the position of the scroll control knob. If the Stop Point is set to 60, scroll rates 

of less than 60 will prompt the text backwards, scroll rates greater that over 60 will prompt the 

text forward, and a scroll rate of exactly 60 will stop the text from scrolling. 
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The Stop Zone is a range between 0 and 40 over which the prompted text does not scroll. If 

the Stop Point is set to 60 and the Stop Zone is set to 5, scroll rates between 55 and 65 will 

mean the prompted text is not scrolled. 

 

7.4.2 Configuring the Red and Black Buttons 

Each of the two buttons can be configured, if necessary to perform different functions from 

standard. Click on the arrow next to the text box next to Action for red button. A sub menu 

will be displayed containing all the different options for this button. The table explains what 

each function option does. Click on option required then on OK to set these options. 

 

 

Function Description 

Caption On/Off 
Switches caption data sent by WinCueProNews on 

and off 

Clear Caption Decoder Clear the caption output 

Cue Story 

Moves prompter back to the last lines of the previous 

story which means that the correct next item is 

prompted even if the running order is changed 

Marker In Current Direction 
Moves the prompter to the next marker in the 

direction in which the text is being prompted 

Next Marker Moves the prompter to the next marker in the story 

Next Story Moves the prompter to the next story in the rundown 

Previous Marker 
Moves the prompter to the previous marker in the 

story 

Previous Story 
Moves the prompter to the previous story in the 

rundown 

Request Control 
Makes multi-button hand control active when more 

that one hand control is in use  

Reset Rundown Resets the prompter the top of the rundown 

Reset Story 
Moves the prompter to the beginning of the story 

currently being prompted 

Story In Current Direction 
Moves the prompter to the next story in the direction 

in which the text is being prompted 
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7.5 Hybrid Serial IMT Multi-button Controller 

 
The serial multi-button scroll control is designed to work with rundown queues (rundown 

queues are not supported in WinCueProNews LT). It is connected to a free serial port on the 

back of the PC. It has a number of additional buttons not found on the I.M.T. simple serial or 

on screen scroll controls. These buttons simplify prompting scripts in a rundown as they can 

be configured to perform a large variety of functions. In addition this control allows the 

attachment of an optional foot control, enabling hands free prompting by a presenter. 

 

7.5.1 Configuring Scroll Controls for Centre Stop Mode 

In the Configure Scroll Controls dialogue box, click on Hybrid Serial/ IMT Multibutton 

Controller. Now click on the Setup button, the Configure Hybrid Serial Multibutton 

Controller dialogue box will appear. 

The General tab is used to set which communications port the multi-button scroll control is 

attached to and, if required, set it up for Centre Stop Mode. 

 

 

 

See section 7.4.1 for details of Centre Stop Mode 
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Centre Stop Mode is used if the operator does not wish to use the FWD/REV button to 

change the direction of the prompted text. To enable the Centre Stop Mode, the check box 

should be checked (�). Next the Stop Point and Stop Zone should be set. 

 

7.5.2 Configuring Scroll Control Buttons 

The Buttons tab allows the user to configure each of the buttons individually. This means the 

multi-button scroll control can be customised to suit a particular application. 

 

These buttons are pre-configured for use. The standard settings are as shown overleaf. 
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Function Description 

Change Direction Changes the direction the text is scrolled 

Next Story 
Moves the prompter to the next story in 

the rundown 

Previous Story 
Moves the prompter to the previous story 

in the rundown 

Reset Story 
Moves the prompter to the beginning of 

the story currently being prompted 

Next Marker 
Moves the prompter to the next marker 

in the story 

Previous Marker 
Moves the prompter to the previous 

marker in the story 

Reset Rundown 
Resets the prompter the top of the 

rundown 

Blank Screen 
Blanks the prompted text from the 

prompter(s) on the on-camera unit(s) 

Caption On/Off 
Switches caption data sent by 

WinCueProNews on and off 

  

Clear Decoder Clear the caption output 

Stop Stop the prompted text scrolling 

 

 

Top Row of Buttons 

Middle Row of Buttons 

Bottom Row of Buttons 

QThe Multi-button Scroll Controller 
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However, these buttons can be customised. When the user clicks on a button they are 

presented with a list of the available button functions which have not been assigned. Select 

the function required from this sub menu. The functions available are summarised in the 

table. 

 

 

Function Description 

Marker in Current Direction  
Moves the prompter to the next marker in the 

direction in which the text is being prompted. 

Story in Current Direction 
Moves the prompter to the next story in the 

direction in which the text is being prompted. 

Request Control 
Makes multi-button hand control active when 

more than one hand control is in use. 

Caption on/off  
Switches caption data sent by 

WinCueProNews on and off. 

Clear Decoder Clear the caption output. 

Cue Story  

 

 

 
 

 Warning! 
  Users should not attempt to modify either the Configure IMT End Stop 

Scroll Table or Configure IMT Centre Stop Scroll Table. If modifications 

are required to either scroll table you should contact your vendor. 

 

7.5.3 Connecting a Foot Control 

At the rear of the multi-button scroll control is a 15 pin D connector for attaching a foot scroll 

control and a button to select between foot and hand control operation. When this button is 

pressed in the foot scroll control can be used to prompt the text. Otherwise the multi-button 

scroll control can be used. 

 

 

 

 

The foot control can also be connected direct to the IMT 9 pin connector for 

stand-alone use. 
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The foot scroll control is used for controlling the speed and direction of the prompted text 

only. All other functions such as next marker and reset rundown are available by using the 

buttons of the multi-button scroll controller. 

The red button is used for changing the direction of the prompted text. The foot pedal controls 

the speed.  

 

 

 

 

 

 

 

QThe rear of the Multi-

button Scroll Controller 

The Foot Scroll Control 
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Appendix A    The I.M.T. Card 

 

In the following appendix we will look at all the configuration options available for the 

I.M.T. board. 

 
 

Contents 
 

Card Layout………………………………………………………………… A2 

Termination - J6……………………………………………………………. A4 

Power to Bus for SCSI Termination - J6…………………………………. A4 

SCSI ID - SW2……………………………………………………………... A5 

SCSI/Parallel Select - SW2……………………………………………….. A5 

Video (PAL or NTSC) - J11……………………………………………….. A6 

              SECAM…………………………………………………………… A6 

External Power Supply - J12……………………………………………… A7 

Composite Video Features Connector - J10…………………………….. A7 

Other Jumpers……………………………………………………………... A7 
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The I.M.T. card is configured at the factory to work in your country. It is unlikely that you will 

need to make any changes to it. If you do, read the relevant section(s) carefully, or consult 

your supplier for further help before changing the configuration of the board. 

 

A2   Card Layout 

 
The following page shows the layout of Issue 1 of the I.M.T. card.  You may have been 

supplied with a newer version of the card – Issue 2. The diagram below shows the 

redesigned end panel. Together, the diagrams will help you locate all the connectors and 

jumpers on the board that you have been supplied with. 

 

 

 

IMT Card – Issue 2. Connector Detail 
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A2   Card Layout (Card Issue 1) 

 
 
 
 

 
 

SCSI Card Connector Parallel Port Connector 

Even flash ROM chip       Odd flash ROM chip  
 
 
 

 

Genlock Port 

Reset Button 

Composite video port 

IMT Scroll control port 
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A4   Termination - J6 

 
By Default the I.M.T. card is terminated, and is expected to be connected to the end of the 

SCSI cable. Termination can be enabled/disabled by changing a jumper setting on J6. 

 

 
 

To enable termination of the I.M.T. card place a jumper 
on leftmost pins of J6 

 

To disable termination of the I.M.T. card remove the 
jumper on leftmost pins of J6 

 
 
 
 

 
 

A4   Power to Bus for SCSI Termination - J6 

 
J6 is used to determine whether the I.M.T. card is terminated and to determine the source of 

termination power. 

 

 
 

If you have enabled termination on the SCSI card you will need to set the source of 

termination power. 

 

To enable external termination power for the SCSI bus 
connect pins 5 and 7 of J6 

 

To enable internal termination power to the SCSI bus connect 
pins 7 and 8 of J6 

 
 
 
 

 
 
 
 

See Also 

See below to learn about 
power to bus SCSI 
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A5   SCSI ID - SW2 

 
By default, SCSI ID is set to 3. It can be changed using dipswitches 1,2 and 3 on SW2. 

 

 
 

When a dipswitch is in the top position it is on. When it is in the bottom position it is off. The 

dipswitch positions for each SCSI ID is shown in the table below: 

 

 Dip Switches 

SCSI ID 1 2 3  

0 On On On 
 

1 On On Off 
 

2 On Off On 
 

3 On Off Off 
 

4 Off On On 
 

5 Off On Off 
 

6 Off Off On 
 

7 Off Off Off 
 

 

A5   SCSI/Parallel Select - SW2 

 
The I.M.T. card can prompt using data sent through either the SCSI port or parallel port of your 

PC. By Default it is set up to use SCSI. Dip switches 4 on SW2 controls whether the SCSI or 

parallel port is used. 
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When a dipswitch is in the top position it is on. When it is in the bottom position it is off. The 

dipswitch positions for SCSI/parallel port selection is shown in the table below: 

 

 Dip Switch 

Port 4  

SCSI Off 
 

Parallel On 
 

 
 

 
 

A6   Video (PAL or NTSC) - J11 

 
The I.M.T. card can produce either a PAL or NTSC composite video signal. The signal 

available from the composite video port will have been set at the factory, prior to dispatch. 

The signal type can be changed by setting a jumper on J11 (Card Issue 1) or with switch 3 

(Card Issue 2). 

 

Issue 1 Issue 2 

 
 

 

 

To enable NTSC place a jumper on leftmost 
pins of J11, or turn Switch 1 on. 

  

To enable PAL remove the jumper on 
leftmost pins of J11, or turn Switch 1 off. 
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SECAM 

 
To configure the I.M.T. card for SECAM composite video output use the same jumper setting 

as PAL on J11. In the WinCueProNews software, from the Prompt menu choose 

Configuration then Prompt Engine and ensure that Colour Burst is disabled. These settings 

will generate a mono composite output. 

 

 
 

A7   External Power Supply - J12 

 
In systems where the I.M.T. card is not fitted inside the PC, it is powered by an external 

power supply. This power supply is connected to J12. This appears as an 8-pin connector on 

Issue 1 cards, and a 3-pin connector on Issue 2 cards. 

 
 

If you need further information about powering the I.M.T. card from an external power supply 

please contact your supplier. 

 

 
 

A7   Composite Video Features Connector - J10 

 
The Composite Video Features connector allows additional 4 composite video ports to be 

added to your PC.  To find out more about this product contact your supplier.   

 

Do not attach anything to any of the pins on J10. 

 

 
 

A7   Other Jumpers 

J1 and J5 

J1 is the debug port. It supplies serial debugging information. Do not attach anything to any of 

its pins. 

 

J5 is the flash reset port.  Do not attach anything to any of its pins. 
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Appendix B   Supported Hardware 

 
The following appendix details hardware devices recommended for use with 

WinCueProNews. If you wish to use devices not listed here, please contact your vendor. 

 

SCSI Cards 

 
QTV has tested a range of SCSI cards. Those listed below have been found suitable for use 

with WinCueProNews. If you do not find your SCSI card listed below, please contact your 

vendor. 

 

SCSI Cards for Desktop PCs 

 

Manufacturer Type Bus 
Adaptec 2906 PCI 

 

SCSI Cards for Laptops 

 

Manufacturer Type Bus 

Adaptec 
APA 1460A-2 Slim 
SCSI 

PCMCIA 
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Appendix C   Wiring Diagrams 

 
The following appendix contains wiring diagrams to aid you in connecting WinCueProNews in 

a number of configurations. You may find that many of the wiring diagrams are not 

appropriate for your system. 

 
 

Contents 

 
Standalone Prompter Wiring Diagram   C2 

Laptop and I.M.T. Box Wiring Diagram (UK)  C3 

Laptop and IMT Box Wiring Diagram (US)   C4 

Edit Station Wiring Diagram    C5 

Standalone Edit Station Wiring Diagram   C6 

Network Prompter Wiring Diagram   C7 

WinCueProNews Net Schematic    C8 

Single Server WinCueProNews Net Wiring Diagram C9 

Multi-server WinCueProNews Net Wiring Diagram  C10 
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C2   Standalone Prompter Wiring Diagram 
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C3   Laptop and I.M.T. Box Wiring Diagram (UK) 
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C4   Laptop and I.M.T. Box Wiring Diagram (US) 

 

 

 

 

 

 

 

C5   Edit Station Wiring Diagram 
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C6 Standalone Edit Station Wiring Diagram 
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C7   Network Prompter Wiring Diagram 
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C8   WinCueProNews Net Schematic 
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C9   Single Server WinCueProNews Net Wiring Diagram 
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C10   Multi-server WinCueProNews Net Wiring Diagram 
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